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https://tug.org/texworks/ (TeX Live©l Z3g})
+ Texmaker (HE]Z2HE): https://www.xmlmath.net/texmaker/index.html
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« TeXnicCenter (Windows):
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BIpX-2 237]|Y oot AA0] Zehy7] £o]7], 27] "upt7] 52 ot g7} 3H$°1°F
stoh E 12 HFEH A27HE Alolo|A §38 ¢t ol B GNU emacs, vim¥t jed 2]
£ Q9K Zlojt}, jed= EMEIDE 7] HiQIF 2 A3t

1.1.3 7| A] F7}517]

olzf) AL tjBEE ] GNU/Linuxoll L= 0] Y= TeX A ARl TeX Liveol A-&Hch,
MacTeXo A= §&3s 7o)X gt Wat= Linuxol © 2<3ict. 714 8335 Windows
i 2239l MiKTeX& 913t 2132 2 Aol =7t
o9 w2 BIpX T 7] 2|7} 7| 24 0 2 Alg-Hrt. olE £ dv|Qt 7|¥ke] GNU/Linux
HHsTai%% texlive- E}i ol &9 W mi7| A& ZEF1L ITh( 7|4 w7 A2k & A2
ot 2 0 2 KIEX 7| |9t 25514 FEE gt
o7k thd thg AAE w2},

l:o

$ mkdir -p ~/texmf/tex/latex

o] Tielele] okl A} W] 2| & Mg},

2. 71712 CTAN v 28 € 117]2] & the2 25t} thAl 2 zip O 2 A& H HE 2
2 Zojt}t, o] A4S foo.zipolet 27| 2 1A},

3. A% %00 &S Eeh,

$ mkdir ~/texmf/tex/latex/foo
$ mv foo.zip ~/texmf/tex/latex/foo

$ cd ~/texmf/tex/latex/foo ; unzip foo.zip
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%] 4 (undo) Ctri-xu u Ctrl-u
AL (redo) ctri-" Ctrl-R Ctrl-G Ctrl-U
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A o] &
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PxgoZ Ctrl-A 0 Ctrl-Qs
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AEAjI517]
AZ 3+ FA¢ Ctrl-H X BS
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ZE7HA| Ctrl-K ds$ Ctrl-QY
Az Ctrl-A Ctrl-K dd Ctri-Y
7] & HFE]
27 Ctrl-S text /text Ctrl-Qs
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HE Gy
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4. THoF sty oA o] EZAY5}A] k=t latex foo.ins® latex foo.dtx HHS
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$ texhash ~/texmf

MiKTEX A 31712 & 27152 ¥ MiKTEX console o] B &3-S o] &5t}

\latex\newpackage & E| 2] 5 C:\localtexmf\tex\ of2foll T3 B %t o}
22 of7|o| 7}11:} o}, Yol A3t xS w2 thg MiKTeX Options S Ag¥sto] ~
‘Refresh now’ HES FErF = initexmf -u HHS HFGol|A APstct o]Ao

0l

Ao

At 5727} A 2] H Fofl= \documentclass A o]Fof t}2 32 0 ZH AHAI
of Mol &8 4 SUck.
\usepackage{foo}

1.1.4 Info H|o]A] 7}
‘man’Y} ‘info’ H|O|A| = AZEQo]o] M EAE P JE|Ho| A2 A Fdl= ;‘JQE
UnixU GNU/Linux A| 280l A &3] AL & &ME}. Rk
#jo] 917 ek o thg 3t o) aal,
1 oS oz ERt
https://tug.ctan.org/info/latex2e-help-texinfo/latex2e.info;

latex2e.info

$ gzip latex2e.info

$ sudo cp latex2e.info.gz /usr/share/info/

$ sudo ginstall-info latex2e.info dir

ol#] info latex2e WO = info ZAE S 5

12 24 Aol $38
FoEG o= *]"_%]'% g i of ghct.
e —E—/ﬂ% H (part) - %} (chapter) -

+ wi7hoh2h=

20|}, ZHalo] o} 721 & of of 7|31
0] 724 07| Zo] that vhgol

e =2 W27 ENAE

(53547 2| Unix TeX Live Al AE10f|A
~/texmf = TEXMFHOMEO|2t= A 2=0f|
stete|of QUCt. w2t HE 2 texhashlt
mktexlsrg *e"’oHOf | QO EICH AJAE
2| X2 M TEXMFLOCAL (%[0 22
IH7 | XS X[ E mof= o] FHE | MHO|
ZQstCt.

o] 2Etojl M MEBHE MiKTEX 4
H*EQ Z= Ol HH 2 flet Aolch 2023E|

E
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File ¥+

File[>Save(*%5}7]), File[>Close(27]) &< ol|t]E]9] 7|5o|t}.

2.1 File>New (A T}+¥)

CEEE

mjo]7) shpg RhE s FE s ohe a2,

9= mR Aol A o] Wi Mt ¥l ol x| slutE HolETh, KXo 2 ¥l

\documentclass{article}
\thispagestyle{empty} % Lf|0|Z| HHS A|A

\begin{document}
% 0] HE2 =AM (comment). 27} MELCt.
\end{document}

BRX o2 443 BAL Rador 3z o)ty 23 o A2 olAlg ¥

\documentclass[adpaper,12pt]{article}
\begin{document}

\title{My Document}

\author{John Smith}

\date{London,\today}

\maketitle

\begin{abstract}

This is a very short article.

\end{abstract}

\tableofcontents

\listoftables

\listoffigures

\section{First Section}

\label{sec:start}

This is the text of the section. See \cite{Gonzato} for details.
\section{End}

\label{sec:end}

This is the end of the document. Please go to Section
\ref{sec:start} to read it again.
\begin{thebibliography}{99}

\bibitem{Gonzato} Gonzato G. \textit{\LaTeX{} for Word Processor
Users}. CTAN,2001--2023.

\end{thebibliography}

\end{document}

20| Aol o B 4 Eglo] nlaiEo] i},

2.2 File[>Save As...(t}2 2|0 2 #7F})

BEX £48 T2 000 2 Wek A 8 o) A8 4 9l RSl

« TEX4ht= BIEX-S HTML/XMLZ #1357 9k 2]de] =2 38 Zolct, °
https://tug.org/tex4ht

[
Al
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HFTeX Liveofl el Iwarp2hs TH7| X &

HE 2 I}
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https://tug.org/tex4ht

« HTMLZ ¥&3}17] 93l latex2htm|S o] 88 % t},
CTAN://latex2html

« latex2rtf= RTF (Rich Text Format) 2 ¥ttt
CTAN://latex2rtf

o detex (3 §187]) = BIEX Bl L& A7 sto] Z29 HAE & s Eo.
https://github.com/pkubowicz/opendetex,
CTAN://detex/

71231 Pandocol2h= 20| Rltt. o] 2 I3 of thsi M= E | 2 Folisto]
ARgstaltt. 2.4742 ¢lo| 7] vldt}. PDF A2t} n] 2 2 7]of ohgh A2 2.6 S Het

2.3 File[>Save As Template(]Z3 22 %)

BEX ‘W E 300l eh 2ol M2 e BEX 17128 BhEs A
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2.4 File>Import(E°127])

Pandoc &50]#| https://pandoc.orgol ot} 22 uj-go| it}
oh3y] Eefo] updS o2 Zof o 2 Wgtsle $obH pandoco] THs £ 67F (S leat 7101 2t (swiss army knife)
Htt.
Pandoc2 BIEX £A1E A/35ke 2838 fig7|oln, 2 7otk %] 7] b=t} thst
Zofo] BN E 2L HMStshe o] W4l 2 asjolot,
Pandoc®] 7|2 EZ 92 Markdown &7oltt, o] xujo 2 HE KX o= o] M
£ o] Foj Rt o] & S0] B}, th2of Ho|= A2 Markdown O 2 ZHAJ 5 FA{o|t},

title: |

This is the title: \

now write the rest
author: Guido Gonzato
date: August 2023
abstract: |

This is the abstract.
<!--- This is a comment. -->
[comment]: # (This too is a comment)
# Section
This is **bold text**,this is *emphasized text*,this is normal text.
If you're bored,go to [The End].

## Subsection

This is “verbatim text'.

6 FILE %+


https://www.ctan.org/pkg/latex2html
https://www.ctan.org/pkg/latex2rtf
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# The End

My dad used to say:

> Damn,Pandoc has not been invented yet!
but not it has.

<l--- end of pandoc_ template.md -->

o

o] A= Antd 7153 BIEX AA R vl W o2 HeS )

pandoc -s pandoc_template.md -o pandoc_template.tex

EEXS 712 o] AAE A4 PDFE 45t W ofe ¥ Yo

pandoc --toc \

-V urlcolor=blue -V toccolor=red \

-V geometry:margin=2cm \
pandoc_template.md -o pandoc template.pdf

-V RO AZFShE 2 S-S A5 Aoltt. Mgt A2 Pandoc AH A& Bt
Pandoc& o] &35l t}aFst L] BAE BIpX o2 HEE 4 Qith, 2 74| ol &
SolE 7o

$ pandoc -s index.html -o index.tex
$ pandoc -s text.docx -o text.tex

$ pandoc -s text2.rtf -o text2.tex

..and so on.

-5 Zeh 1t “standalone”®] oujo|c}, % 22 w2 YT WEX £A7F Bk ol

Markdownol|A #2413} k=
o] 272 2}7} 271940}, Markdownoll= ofe] 850l 913 24} 4Bt 7)) 224
2}, 45k2 9] 2] Yol ZF Markdown AFgotct k7t 2fe]7} Ql+=H, pandoc Markdown
= 71802 342 thg 3} o] A 2sitt
« PZ(in-line) AL $2 AZSI § 2 BUTH =
o|Ao|t},
- 3 (displayed) 2412 $$ BT} $$ 3 Atooll Hojd=

o

of 23

fol

5 2409

i

=$7

ol

9% 4419) 2ol 5,9} 2ol Ano] 22 Butoh ki A wlo] ol A 2ol ORF 502 Markdownol W Jfee]
SHLFR! 2

o £R& 78 4 e, Waole] TAL 9ol olola] nholch, Eolspl Eag L% Mullimarkdown \\ (51 \)

%% 44/ Yol e polof gk £AI7E ek, ZAHE \\) F100 icko] 2 200l S5,

2] & 4418 Mok Sk amsmath 2] <aligned>2}F 20| <equation> WHollA & 4=

3= Markdown 241 & 24T of o0& M2 koTpX TH7| A& 2 E5H| 8H= Aot}

title: A=
author: A At
header-includes: |

2.4 FILED>IMPORT(E0{27]) /



\usepackage{kotex}

ook XalTEX ZHut o] & 23ttt PandocS A3y e uf th-3-3F 20| --pdf-engine
S4E Folof g}

$ pandoc --pdf-engine=xelatex -s -t latex mywork.md -o mywork.tex

B E Bo|| k= Markdown &A1& 2Hdstal A 2]5t= A E2 B}

2.5 File[>Page Setup(zl|°|A] 2A)

|2 27], A FEF, oS HAA5t= LRby HR-2 \documentclassoll &4 Thato]
E FE=7lo|t}. £4] A7]|= adpaper, a5paper, b5paper, letterpaper, legalpaper,
executivepaper 59 stUE | Aottt B2 portrait”?t 71290 d|, landscapes

ofstol 7427k 2] §A17 HEE v 4 9k, oS 59 thea} 2.

\documentclass[a5paper, landscape,12pt]{article}

[ 29 X‘Mf._ counter2} dimension
o9 R0l 21X nhale W0z HAE Ha10 W Aol sLoplo] S 220 PEIX 41, IRi0lE S
A HA| o] AF vpRl2 \setlength §g o= gt} o] -2 H4el 712-E 9] ATBA “IH2E" 2t X| A5k QI O

1o S 8 T Sl = Mylxz 20N 822 102 87|, 0|22

&hS vk AR8shE Aol geometry 7141 E o §ot= o) B T of #7171 B 71 2E{0] chstAfBt 712 Efekn

o] &5t &A| Afo]=, mhRl Zo|ef 22 uitn|E Bl g2l et HofotLt,

o= Y2 e Melirlglo] QlojA] o 7)o tf AT 4= Qi Ti7|A] EAE QlojRE S

H3tct, ot oo A3 AFERS o EQl=d €5 getu| g = T2 A FAo AFEE

2 e 7ol glon, &) o & 57] sl Bl A= ot
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r
)
ol
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+
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o
3
Q
<
ig
U
kl
inl
i o

% memoir/oblivoir A= geometry
of= CHE WAlo| ZaiA XAl H|O| X
{|0]0F A7 20| ULE. oblivoir 7t
\usepackage{geometry} % top of document X2 5t= fapapersize TH7 | X| & 2HHSHH &
e = QUL IH7|X| 2ME & 05}2}. geometry
\geometry{paperwidth=25cm} 7} memoir/oblivoirOllA S22 Y27 |X|=

. ot=Zio2 U QoL SeiA KK X
\geometry{paperheight=35cm} MR TS Ao AFR S A= Qirh
% or: \geometry{papersize={25cm,35cm}}
\geometry{width=20cm} % total width
\geometry{heigth=30cm} % total heigth
% or: \geometry{total={20cm,30cm}}
\geometry{textwidth=18cm} % width - marginpar
\geometry{textheight=25cm} % heigth - header - footer
% or: \geometry{body={18cm,25cm}}
\geometry{left=3cm} % left margin
\geometry{right=1.5cm} % right margin
% or: \geometry{hmargin={3cm,1.5cm}}
\geometry{top=2cm} % top margin
\geometry{bottom=3cm} % bottom margin
% or: \geometry{vmargin={2cm,3cm}}
\geometry{marginparwidth=2cm}
\geometry{head=1cm} % header space

at}

\geometry B thil thZ2d f7|A] FHES F= = Ao

\usepackage[left=3cm, right=2cm] {geometry}

8 FILE %+


https://www.ctan.org/pkg/geometry

2.5.1 Page Setup[>Headers and Footers(}slc HF)
fancyhdr H7| A & AL&-5}H \pagestyle{fancy}at= HH S & 4 JA Boh. 0 24
o] A hol] &l  — book.clsztH #(chapter) — & dHF+= FTHAFe} 5hctof mo]A]
WS el ShEmE g Al o mopo 2 phsol 2t Aottt Mg AL Al stoke
Aw 7hssith, 2t iF Jod e 9%, Thed, 2% A REo R LAshey), 7 B
A% 3, shed ¥, 2% Yo| 22t Mg Wt b BN S B

\usepackage{fancyhdr}

\lhead{} % empty

\chead{Hello,world!}

\rhead{Page \thepage} % page number

\lfoot{}

\cfoot{\textbf{Hello!}}

\rfoot{}
2.6 File>Print Preview (&3 n|g|17])
U FEu st pdflatex ==+ xelatex, lualatex 2 PDF TS HERE THE-0]A] 2}4l 0]

£7] 2= PDF R|2| 27| A4S A¥gstd Hr},

hyperrefo]t} url 22 sj7| A & 2H B2} 74535 PDF otd 2 BHET o]9
A= 41882 Heb ey pdflatexoll Al A5 H71 A& AHSE of 2418 He &
U, 12 o] ok AT 2hA IS AL 4.14 0l A Th2 T

2.7 File>Print(4})

ZHil o] Ab&-5al Q1= PDF v] gl 7] 19| w0l File[>Print &%-0] 9l& ZAoltt

2.8 File[>Versions(H{A &)

H7 o]y Tt 35 LS st =2 alo] W 71| Qlt}. old AU & AS 5=

ZAFE A27HE RCSE2 T A2 2 ol o= AT 2R o FX Festa
Z AFEAFS A Y 5H= Subversion, Git, Mercurial Z+2 =17} . W}, Gito] 71 o]

AFGEIE 2Rl BEX 8 Telo] BejAl s ohe BAE Fustet.

o https://www.desy.de/~bargheer/gitintro/git.html

(%19 e moir/oblivoirofl A= fancyhdr
Qb= C}Z gtAlo| ZafA XHA| ‘H|0|X|
AERY MH HEAIO| QICE fancyhdr®f
SEE UK Y= AR AB K
QlOLt SefA Q| MM utAl 3 S A|of At
£ giCh

EF 10| om0l M & Z3H= HHOI GllAIE
OiIT fancyheading | Z40|C}. ¢4xH <]
fancyhdr O HE 2 X507 | = ot
EI=Z \fancyhead, \fancyfoot
FPO = dYst= 20| ELf. B9 LH

Z2ME CIXfolEt mjof] a1 2{stCt,

|
x|et

-
[ofz1

IXXH= Eps D8 AQlS
Aoz E‘J'Et LFE Atetg elgsta QUK

OJEE‘ OE pdflatexoﬂ)\ﬁ e

ST Q| TeX Live A|AEIS AL X7} O AlSLHX|
SOt EPS 7S PDFE H2tsto]

Lot Z= Ol XE 2t of QL

« https://www.math.cmu.edu/~gautam/sj/blog/20130929-git-quickstart.

html

3 Editd¥%

o] wl ol sgshs AFF2 BIEX Q] 7]-50] otz w3 7|9 ehadd Zlo] gt WA & 10
A, Zetg7] - EAlst7) - 2ol 7] - 2 7] - Zhobubat 7] (Edit[>Cut, EditP>Copy, Edit[>Paste,
Edit[>Find, Edit[>Replace) 5l sl ot= 2 7HA] ot E 9] 7|ulRld 2 Au e},

2.6 FILEDPRINT PREVIEW(Z3 0|2|E7])


https://www.ctan.org/fancyhdr
https://www.ctan.org/pkg/hyperref
https://www.ctan.org/pkg/url
https://www.desy.de/~bargheer/gitintro/git.html
https://www.math.cmu.edu/~gautam/sj/blog/20130929-git-quickstart.html
https://www.math.cmu.edu/~gautam/sj/blog/20130929-git-quickstart.html

27} o197 517] el Mol 7 E ek A|e R Ro) 54 AEtele Hgajen
giE2 HeF o7t ek BEXOIA olo] st AHe FBER Selu) 87
Qo] B Zoltt. ol SW Ui HAE] FE 2R £42 Holselwl T o)A F o
7H g o 2 gk,

this is \textbf{bold text;}\\

this is .also this is bold text;

i;g;ji;é:e?_zl:}te“ PN this is also bold text;

this is bold text,too! this is bold text, too!

\end{bfseries}

3.1 EditD>Autotext(AHs&A)

].
o} 7| x}Eek4ole} st 71 oAt ‘PS’Ebal Eto] W5l ‘PostScript’ 2H 1 7\}50 2
Aol Qe 22 watt}, ofgEl7} o] LS sjFE}. BIEXolA ool sigs
A2 gk oha} 22 7o

\newcommand{\PS}{\textsc{PostScript}}

o] ZA| o] gt th-3of \PSet1 5= 2 \textsc{PostScript}etil YHsh= 2t
2t} thaga o] F sttt

4 Insert ¥

o2
)
il
p—

4.1 Insert[>Breaks(

.+ o] Lhiro}x|%) b BUBAE ~ (Yu) 2 HATT

« A ¥ Wr7]= \linebreakt \newline& &t} 2| 2o of2lf 27|15 Heaf, M7 xats \\& \pare} 2ixis| st
v bl 30 Ll o] = 5F A o] v o o = A 0] Ao= AWt QoL Hxp= &
EE‘C\\E_%XH °<}>1 L‘]"T‘ﬂe %T/\}\L_Eﬂ O] LLH‘— Z_]'Z:!E Hﬁ—O—EETME}(qII MZISHR| 47| I{20f O] Y=o 2 SF LY

A S \\ = HRClo)AE (B4 B 4 90)
\\[1lcm]). \newline@} A2 ZX|2t H{E (array,
. HES BOe AFsted W 22 AU \par Y £}, B g o) W FA Blow

. 292 Ho|A & Y+ \newpage == \clearpage H5o| tt.

\newlined} €2 \linebreak= AA] & ZL7}A xj2c}.

I am stretched!\linebreak I am stretched!
But I am not.\newline But I am not.
Another line.\\ Another line.
0k,now you get it. Ok, now you get it.
3HH \clearpage”} \newpage® CHe & Ax| 9 x|712] BREEo] Qe ZZE(T
oL} B)5 2% 223 0ol Ho]A S Lherhe Zolt, E2 o] thajAs 4143
ol e,

10 INSERT Hl&



4.2 Insert>Enumerated List(H g JI 2
Udd Et(list)oll= 22 1o A (bullet) & £0°]& <itemize>t HSE €0|+= <enu-
merate> $730] Itk \item Haoll 34 AAE Hojsto] Iy Bt 2ot Hz

7158 e BYo R uhE 4 ik

\begin{itemize} . . .
\item[*] with an asterisk; with an asterisk;
\item[-] with a dash; - with a dash;
\item[.] with a dot. with a dot
\end{itemize} ’ '
7t Gl A E FF ofF (A o] ZEE v EUE R LB 1
BE 442714 HH 7"]'7_‘?451(counl‘er)l AEFA S 2 A Q5= Aotk \labelitemi,

\labelitemii, \labelitemiii, \labelitemivitemize 2730l si3t1L, \label-
enumi, \labelenumii, \labelenumiii, \labelenumiv+ enumerate2] 2}l 7}-2-F
AEFY ol

7128 2etdof & 527} 9lth \arabic Z=Z}o| 1 \ roman< A &2} 2o}
ZAHCE EH 82 viii2 #7]), \Roman thZ2}F 20t 22, \alphet \Alph+ ZH2t
dubd AFAket Gubsl tiEAtolch. 1 4ol \ fnsymbolo|ghs & 9l o]of s
A= Yol (163 0] A]) A stzlct.

o ‘olHp

- =2u

\begin{itemize}
\renewcommand{\labelitemi}{*}
\renewcommand{\labelitemii}{-}
\item first level,item 1
\item first level,item 2
\begin{itemize}
\item second level,item 1
\item second level,item 2
\end{itemize}
\item first level,item 3
\end{itemize}

* first level, item 1

* first level, item 2
- second level, item 1
- second level, item 2

* first level, item 3

Eof|A 2ot sextet th22F dublS 22 vzt o] St

enumerate 2]

\begin{enumerate}
\renewcommand{\labelenumi}
{\Alph{enumi}}
\renewcommand{\labelenumii}
{\roman{enumii}}
\item first level,item 1
\item first level,item 2
\begin{enumerate}
\item second level,item 1
\item second level,item 2
\end{enumerate}

'BIEXOl o5te] MEUL B A, BlaE, O e HrE @

Fll’
_{\1

12} 712 B 2 74 Elof .

o=

BF 1< description>2 2 t2[0f (S
QX2 FOIE) HAES 1 M FA Q|
ZHhe BhECH

e

Tt oblivoire P24 7
HFetCh 1 S0ll= \ga
gana \onum, \pn

um .
ol 1w 7t 0, @, @, (12

T

o

> P
=)
=
=

3 o
<ol
_Lg o

a

NS
B NS
ot \w

o

F

W
Ho

4.2 INSERT[>ENUMERATED LIST(HS £
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\item first level,item 3
\end{enumerate}
A first level, item 1
B first level, item 2
i second level, item 1
ii second level, item 2

C first level, item 3

H
iul
ru
oL
rE
|o
HU

25 ARG AT

o2 ehdth. 7 42 vlejo] s ol9jo] BaE

numerate 37| X 5 2= ¥ °] lth. 1% <enumerate> 7S WA
VA SFRCE Aali17hed 3232 &

}7H2-E 9] & Al o] Z.PZ.P\Alph \alph, \Roman, \roman, \arabic
= F7letHH 5

52 FolFrh

\begin{enumerate}[{Example} I.]
\item First example.
\label{item:first}
\item Second example.
\item Last example.

Example I. First example.
Example II. Second example.

Example III. Last example. Go

\item Example 6.
\end{enumerate}

Go to Item~\ref{item:first}. to Item I.

\end{enumerate}
I8 2] 4 A4S o R 7heEl S A elste)
\begin{enumerate}

\setcounter{enumi}{2}

\item Example 3. 3. Example 3.

\item Example 4. 4. Example 4.

\setcounter{enumi}{5} 6. Example 6.

o oA A paralist 7] A S AF&-5HH HL}. <in-

I'll throw in a list of items:
\begin{inparaenum}

\item apples,

\item pears,and

\item oranges.
\end{inparaenum}

\begin{inparaenum}
[\itshape a) \upshape]
\item apples,\label{first}
\item pears,and
\item oranges.

The same list can be labelled with letters:

The first item is \ref{first}.

(% enumerate IH7 | X| 20 o Z&3
7|58 ME3sH= enumitem 7| X| = ULt

7 memoir 22§ A= enumerate
IH7|X|9 7|58 XEetu QIOCBE HER

2o =Tt gt oblivoire

7h e, @, 7,00, 9,1, O, @), @

2h= &5 H2| XIAIXE F715t QUL
oblivoir 7} OtL|2}H koTpx Z=7t THZ|X| Q!
dhucs-enumeratelt dhucs-enumitem=
& nstet,

INSERT M|+


https://www.ctan.org/pkg/enumerate
https://www.ctan.org/pkg/paralist

S22 BHX 93 AAS

$ \$ or \textdollar
& \&
% \%

\_or \textunderscore
\{ or \textbraceleft
\} or \textbraceright
$<$ or \textless

$>$ or \textgreater
\textbackslash
\textbar
\textbullet
\textdaggerdbl
\textdagger
\textparagraph
\textsection
\textcopyright
\textasciicircum
\textasciitilde or \~{}
~ $\sim$

® \textregistered

™ \texttrademark

2 \textordfeminine

° \textordmasculine

>0 Mttt o — -V A

R

SEAE B Y

==
Jm
i
rr

\end{inparaenum}

I'll throw in a list of items: 1. apples, 2. pears, and 3. oranges. The same list can

be labelled with letters: a) apples, b) pears, and ¢) oranges. The first item is

a.
el clol 50l Aali1 247} 4 AR ABHRAHEH £A2 Sa
paralist'= o|8ol = ChFer 4. & 4 9o m 2 71X BAZ Yol g Wkch,

4.3 Insert[>Special Character(54&4})

wﬂ'HANEnhmngEw&qmaﬂ& £ A2 7198t o] 2AH5L ool
2ol 7Lt 43t BEo| A AL of B4 vhARE Abgstelof St E 25
Ea.
e
581t
=3

s
T

)

23}

24

rlr

th2 B o 2 ASCII ZE9F \char &S 2= Zlo] it} o
7}¥ZF\char36 \char38\char94 \charl26°]2}1l ¢]&35}o]

i

.
Mo
i

>
il
ilo

ne
o &
;O

AOFo EHW
Tﬁt?

rm

AU 7125 AlFohe H71A = Ao A& EH pifont 7| A=
\dingT} \dingfill, \dinglint, \dinglist B2 211 k. \ding HH2= EH
F o] Jul(Dingbat) 22 A=t \dingfillZ} \dingline& \fill®} \lineol
o33ttt \dinglist 2742 QIAtE F0i7 8l FEE & M2 AMESh= Y AES

o]
=

opEr
N

S
-

ot

™
Ny
l

AR

7t
tE

"oblivoir 54+ T{7| |2l xob-paralist
A enumerateOfl CHH A

Xz ot= 2gE 7
S FMH &L

4.3 INSERT[>SPECIAL CHARACTER(EL2X})
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https://www.ctan.org/pkg/pifont

RHEC)

\begin{dinglist}{43}
\item one ¥ one
\item two I two
\item three 1= three
\end{dinglist}
thg 127]9] dingautolist $74-2 F0171 Q1o st e CRECTE
AEZ WEE 2R 7|52 AlEstt.
\begin{dingautolist}{172}
\item one ® one
\item two @ two
\1telT1 three . ® three
\end{dingautolist}

7|15 EAE U EobA] o 7] A th AFE 4= gl 1 thAl “The Comprehensive BIEX
Symbol List' 2= B4 & 471518 3ttt CTAN:/comprehensive.

43.1 |23 715(€)

5 7hA WA O ALG

rlo

F23} 7| T eurosym 37| A = A A}
7hs .
\usepackage[gen]{eurosym}
\usepackage[official]{eurosym}

S AL 2SS \euroHES AL 1 E
A dAdo) wet dekzlct, [gen] 42 FH

g, Tt 2

€9}tk o] 7157} Qi mofo] &
EE taelol g2t 25} 7158 Pt

HhH = A B 7)o Aol €2t S Qlafistet, n]Eet x}o] 7} Qlch \officialeuro
oo 2 ol Ao EXA] o] ‘official euro’ ZYS A& 4 Uk ?

2~uk
T

o] mf7] A= ool +E-2 A

o
T A

FE3} 7| S+ marvosym 7| Aol A & A|-Z-5h=d
71552 g5t Sk \EIR BH o2 €2 AT 4

4.4 Insert>Formula(438H2]

Ifﬂ' XL Eg] _/;1\19,] zrﬂ-oﬂ 71—14 o]
(inline mode)— 2 ot{W $ R =2 1 /\] Fy

I like math: $x”n + y”n \neq
z”n\ \forall n \neq 2%
is my favourite theorem.

Ilike math: 2" 44" # 2" Vn # 2
is my favourite theorem.

B2 gUog zaHt o

nJlo

<displaymath>9]— <equation> 72 4514

5
REC}

S [JAZgo] BT (display mode)2tal

(S5 TeX Live 2 A4 K| SACHH HZIHO| A
texdoc symbols == texdoc
comprehensive '?5'%'12 Lizi&Eat,

(55720 ol ot} QIS S LIEIL S 7|5 W, ¥2
\textwon, \textyenQZ ¥ S 4 L},

(2 amsmath IH7| X2 2 =6HH
\eqref':':‘a%%—?—?i':f ChS oflofl M
“Eq.~\ref{eq: ferma‘c}”Ef_T'_%+
\eqref O = HHIM Eq. (1) 20|
LIEFHCE,

HO
T =

INSERT M|+


https://www.catn.org/tex-archive/info/symbols/comprehensive
https://www.ctan.org/pkg/eurosym
https://www.ctan.org/pkg/marvosym

Fermat's Last Theorem
defined as:
\begin{equation}

X*n + y*n \neq

z”n\ \forall n \neq 2
\label{eq: fermat}
\end{equation}

Can you prove
Eq.~\ref{eq:fermat}?

is

Fermat’s Last Theorem is defined
as:

"yt #F2"Vn#2 (1)

Can you prove Eq. 1?

4.5 SymPy AF&H

m2 e Qojot AL EAEL 44 Qo] HE 24 S ALEAT SymPyeh wto] 4
2

7} e O

=

3 = x X
2 SymPy oflAlo]th, 92 4] (£ — 2) T RS WG L - LE 4 22—
(o3}

3
82% ol oH%*on BEX 155

EIEX 42 22 4 3l mtojdo] 458

In [2]: init session()

types: python)

>>> from sympy import

>>> f, g, h = symbols(
>>> init printing()

In [3]: expr = (x/2 -

In [4]: latex(expr)

Out[5]: "\\frac{x"{3}}
y~ {2} - \\frac{8 y"{3}

In [1]: from sympy import *

IPython console for SymPy 1.9 (Python 3.10.6-64-bit) (ground

These commands were executed:

>>> from  future  import division

>>> X, y, z, t = symbols('x y z t')
>>> k, m, n = symbols('

Documentation can be found at https://www.sympy.org

Outf[4]: "\\left(\\frac{x}{2} - \\frac{2 y}{3}\\right)~{3}"'

In [5]: latex(expr.expand())

*

k mn', integer=True)
'f g h', cls=Function)

2%y/3)**3

{8} - \\frac{x™{2} y}{2} + \\frac{2 x}{3}
27}

ojA| o] A2 RE dojA= 42 ot E 2 BAMS o9 7|tk & \\& \Z =

75k st ek,
ghof nho] 4l Qlojo] S
BESAWEE AT 2500

S python BIEX 7] 2]+ LaTeX Expression project

4.5 SYMPY AF2H
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https://www.sympy.org
https://www.ctan.org/pkg/python
https://mech.fsv.cvut.cz/~stransky/en/software/latexexpr/

4.6 Insert[>Footnote(Z}3)

Z o3t 22 \footnote[n]{footnote text}et= W o} 4 xSl [n]= 2+
F HSE vttt \footnote P2 Tojet npy®, 4 H, 7|e} EHE S FHof] Fojof
Sig=

Mo Al 712 e Yoo HAES Zb3 7| S 2 ARG \footnote 7 EHE

\renewcommand{\thefootnote}%

dreee] mad) This footnote™ ™ says it all.
This footnote\footnote

{I mean this one.} readme'y 1 ean this one.

says it all.

ol Wl ALY 25 WiB g Rouleaht 7| SRAR Uehd 4 Uk,
\renewcommand{\thefootnote}

{\Roman{footnote}}

This\footnote{The first.} This' is the first footnote, and this" is the second.
is the first footnote, The end.”

and this\footnote{The second.} ;

is the second. Hﬁz fzz(tmd
\renewcommand{\thefootnote} At last! ’
{\fnsymbol{footnote}} ’

The end.\footnote[8]{At last!}

\fnsymbol{footnote}=til 3t H 2}
747}k th o} F Jle] 7| S EA 7L mE T, « +
SAgk Zhol oA M2 ohE 2 22 HEs g ool Y 23 HEs

W7 23 The 3} o] sl

This\footnote{the first.}
\newcounter{\myfootnote}

\setcounter{\myfootnote} This' and that® are footnotes: please read note!
{\value{footnote}} again.

and that\footnote{the second.} ;

are footnotes: please read note ztheﬁrst

\footnotemark the second.

[\value{\myfootnote}] again.

59]: minipage U0l = B hs B E9| 25 7B & 2h=tl|, mpfootnote©|tt.
\thempfootnote® 1 7S Q2h3F 4= U}

4.6.1 Footnotes and Endnotes(Z32} n]F)

endnotes 7] A= \endnotez}t= M2 Y-S #| L3t} o] WS \footnote At

gof| thAl 2™ H|o] 7] sltof] ZkFE o= th4l \theendnotes H o] Fo|+= 9o
Zota A ESHCH! Zolut Ao npz|ghof] M-S ot Q125  ujjof -85}t

INSERT M|+


https://www.ctan.org/pkg/endnotes

\footnote o2 U F o] 9
a137) YA E e e 5

lo
Il
N
:?L_’,
A
u)

\let\footnote=\endnote

2] 3 ofefet 22 Al 20| WS EA vhxstel Hof Pt} 2

\newpage

\begingroup

\parindent Opt

\parskip 2ex

\def\enotesize{\normalsize}
\renewcommand\notesname{O|F} %% HA} 7}
\theendnotes

\endgroup

Ak the 3} o] LpEpdT

e

fo]zte olzolt}.

4.7 Insert>Indices(Ex})

8 =3, & 23}, 1% 23 52 AASHE 2L XA UL kgt doltt the
2 onl

=
B2 249 A MA \section E= \chapter Ho| L} 7] Hoj Hojd

\tableofcontents
\listoffigures
\listoftables

W7t ob o 9= 2 A Aol olejdt 75 o] gtk Y= Z2AA o] SQIE] KEX

2
N
N
9
4
2
2
&
o
ojo
[
N
i
[
&

(2 gndnotes S AIXFE If 2= EfO|S
O3 2= \notesnameO| 11 7|£Z}0|
“Notes” 2 E|0f ULt 07| M ot=0{=2
Hoi5t7] 2/8f 0| ({2 2 E renewcommand
SHRALE.
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F 3: <tabbing> $7ol| M AHEE= H

3y &
\= B AF A& A3t
\> ohe 5 A 9132 ol 5H).
\+ ® AE 9125 3 7+ 9202 R},
\- B AE 9135 o 74 9o 2 YT,
W o] 2
\pushtabs L& ] A% Q2 E A&t}
\poptabs  AFHWH & AF X E Eol20
one \hfill two\\
\vfill one two
~ \hfill three \hfill
= ~\\ three
\vfill
four \hfill five four five
\null
QA o 2 BXol A= 5 ol4e] BulE o0 2 Yol w 142 weatAl sheth
E oY) au2 g shute] uf o 2 ZhEsitt, gy 419 F97F oA HE A
12 5 oj4e] Bujg A2 olof shchEl, “HeA|x] ek BUel ~ R5E AMEa)
Zo]2 A 4sto] g o FHhH \hspace §H S &0} »

This is a \hspace{2cm}

2-cm-wide~~~~hole. This is a 2-cm-wide  hole.
4.9 Insert[>Tabs(§4)
<tabbing> ¥73-2 TAB 7|15 =& wjo] 521t gAle At A3t HrES
(column) Y X| 2 v 2|5} o] ARSIt 3 32 o] oA F2 20| = HHY S 295

9Ict.

te Ite

o Abg el o Alolct.

\begin{tabbing}
s o 9I2E 4%

~ \hspace{lcm} \= ~ \hspace{l.7cm} \=

One \> Two \> Three \\

One

Zero \>
Zero \>
Zero \> Two
Zero \> One \> Two \\

\pushtabs % & ¢|Z| 2

new tab 1{\dots} \= new tab 2 \\
new \> tab \\

\poptabs % A&3UE = X =¥
Zero \> One \> Two \> Three
\end{tabbing}

\> \> Three \+ \\ % o ZI#¥
\> Three \- \\ % St Zt& 2|

~ \hspace{2.2cm} \= \kill % O| L HA|5}Z| %2

e

2 Ho oL
otrnpE
Slo £

ZtA0]| ChStod \vspaceS Z2
2= ALL CtEk\vspace&=

=l CHSof| (B3 LI ZSHA

ertical modeOf| Af) M{OF BHCf,

2 oy HU 4>
HU g 42

Ho
<




Zero One Two Three

Zero  One Three
Zero Two Three
Zero  One Two

new tab 1... new tab 2
new tab
Zero  One Two Three

<tabular>2} <table> &7 = Lo} XA},

4.10 Insertl>Cross Reference(22}&x)

Bl AEo] 2hil g gal 2hl 91| 2 WA RSt fl8lA \label, \ref, \pageref Ho]
AHEEITE 2L prefix:suffix P41 22 o] Sl Zlo] EFEHo|th, 7| prefixe o ! 4]14 0|I|%'$ 101 \egref

S =9 o= Zot. H(chapter) HE Ol cha, $4] M &of eq, 217 oll&= fig, A (section)

of| = sec, &0 tab.
A, #, 39 5°] o A& #Ho|A & FRoHHH \labeld \ref & th& E7]ek Zo]
ArgEr.
\paragraph{Example.}
\lz?bel{par:example} . Example. This paragraph ap-
This paragraph appears in ears in Section 4.10 on page 19
Section~\ref{par:example} on p ' pag ’
page~\pageref{par:example}.
EE prefixs 2H4l 9] uhgoll E= A2 2 A= Hrt. enumerate 2| AE o] 283
o & ®Bx}.
\begin{enumerate}

\item{first step: skip to
\ref{item:end}
— \label{item:start}} 1. first step: skip to 3
\item{another step
< (unreferenced)}
\item{end: go back to 3. end: go back to 1
\ref{item:start}
< \label{item:end}}

\end{enumerate}

2. another step (unreferenced)

4.11 Insertl>Margin Notes(°] ¥l &)

Y& Zrasich \marginpar{text}&ta ™M Hc} o] 7|52 Q= T2 A Ao = Z
27] o2l Hold. B}l E |

4.10 INSERT[>CROSS REFERENCE (A=) 19



4.12 InsertD>Text Frame(Zd|Y)

(]

oz FHM HAE
oF
o

Apolofl 4] Lhiof 2] A

=} HE T

H|oj x| o] a7

_CL rlr

L
L

w0l 2] o] 57 gx|o] AAES T

ZefA] A YeRd 7] 95l 22o]=t] o] A]
A ARl FAE el T textpos
7] 2| & o] &5 =t 1 01]%1] 2P A5RE

A)ol] Bt

A A 7]= Zo] ol <minipage>
(FlY=elA)) 4= & 4 Ak A=
B Q= HIAE = minipage 2 &

o]X Zo|t}. minipage HA+E 1 AL

IS PRt P EEN
2 58 Aoltt. <boxedmini-
page> 70| -2 o] 52| mjj7] 7|
o] &5tof A|ZH et

e

Bl e abspos 7| X| € =XM%
| beamerOll A textpos 7t Y27|=
412 mehz & 9\ct,

=

=+
=
S
|

HD Aim

oJollA H|o] |7} Lho] Z| 2] =

<minipage> AH&H 2 Th&3 22 FA A= 715k
\begin{minipage}[position]{width}
iéﬁd{minipage}

<boxedminipage>°llA| Ze| Y} HIAE Apo]o] IHA L th-Z o= 3Tt

\setlength{\fboxsep}{5mm}

4.13 Insertl>Image(°|n]#])

._’Z_Q‘] : O]D]X](lmage)gl' j%’(ﬁgure)% E]'% Z O]q /\o]_}\ﬂé_ 7/1% 4~147‘<——'j% EE]'
PDF, JPG, PNG, TIFF *° 5t 2 ® o|u| 2] & A4 g 4= SIt}. PostscriprU EPS ohd %7 xixj
& 2312 Brrel oot AREIE & ol Mg st 3¢l

TIFFE O{7|M Agstd
UL T TeX Live A|AE2 TIFF Z2HO|
ol o] wAdS A BSAY 60jx12 = x| @six| rort M=l et

=

PDFE Hglel= WS okm 9] 8 Ao}, ¥ EFE 0|&3t0] PDFL} PNG £ convert
e sfiz=0{of gict.
725t 1 7] 4] graphicxoll A #|3-3H= \includegraphics H 2.2 o|n| x| & xg}gt
4= At

[SF2onjo| x| 2= 125 H Dt
This is a lovely picture

This is a lovely picture
\includegraphics[width=3cm]{piper.jpg}

of a guy playing the pipes.
of a guy playing the pipes.

height, width, angleZr2 T}2tu] | & & 4= It} widthe] A% ©9+= 219 B 7]

M dolg Folk H a1 g AEL 8 Zo]of /Jdigto g Fojsfx
width=\textwidth % THO| F= LH|

width=\linewidth % A 2Fol 2E YH|
width=0.5\linewidth % linewidtho| Z&t

At
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https://www.ctan.org/pkg/textpos
https://www.ctan.org/pkg/graphicx
https://www.ctan.org/pkg/adjustbox

\usepackage[export]{adjustbox}

24S Fosto] e \includegraphics H#ol

Bg 27h8 02 Rofd 4 ek oAt 5 A

adjustbox 37| 2] of| [export] &S &
left, right, center, outer, inner2t 22 &

AL Thg el Ao A 21 Zol},

(%5728 1 XH= “multi-column text Ol
gt 0 811 Ql0fM ICHZ oLt Ol
S22 Xxtel H2fol Suict Hafotojnjs

tw05.de(0m1) Bl AE0|| ®E3HCh 1 fjof
StCh & inner2ts AR LHE (spine) &
(RLEZ 1|0|X|e] 1% mﬂﬂolxlol

REZ) outergt= é ERiR
7tal7|= 24o|Lt.
This is a lovely picture This is a lovely picture
\includegraphics%
[width=3cm, right]{piper.jpg}
of a guy playing the
< pipes. of a guy playing the pipes.
u] =1 o|5) )7} PDF #]E} ol z|oj u]alo] Eo] 24 b Ae B W E gict.
21 38 o|u|A 5L Al e R Ads] AR = Ar 9ot
[9=} adjustbox+= Pll-¢- Tt 7]5= Al&-5h= 71 Al o|t}. #7| 21 & 2= ff [export]
FAE Fe o s B e, F9 B2 42 \includegraphics H 2 g7 227
3= [Export] = A
vertical alignof] T3t o & s} Sof T30
\includegraphics[height=12pt, raise=-1lex]{piper.jpg}
230 44 91715 [l 22l cistel sl 2 7t gk,
ZFo|st M2 raise keyE ¥ \includegraphics 7]Ec} Lo Adsfof stch= A
ojt}.
4.14 InsertD>Figure(&Xx)
29 (figure) 8732 0] 1|7 (image) & A AsH= AT $L51A] ek, AM figureo] U1
£o] ojr| A B xA glet. figure Ho]A] Ulo] A H EA X5 2k Zo] ofg}
ek s Zolw BE Mo] 231 17 Mol thstel At 4 9k, o] Y Fhe
20| <figure> 73 oltt. otefjo] F Z7 figureol T3t ol & Kol
\begin{figure}[htbp]
% [htbp] E2EJt =Y A E AH
% here,top,bottom,separate page.
\centering =8-)
\texttt{=8-)) 77 1: o] QA M et
\caption{O| QfLHA HAE LIEtLH= Anel g
— ADrYE|}
\label{fig:mysmiley}
\end{figure}
ool & A2, figure= BIEA] ZEE YT HEZ 1 9 X]0f YEtdthe B0l
u}% AtAolt). 9= =2 A ek bl msle] 37| th2 o] figure'So] WHH 91415 27
Sr=The ARV, figure} 0l 9171 BIEXo] Beke 71 27 2) 9% 2 “mirhy =
21

4.14 INSERT>FIGURE(& &)



\begin{figure}[htbp]
\centering
\includegraphics% ,

‘Gruplot 30 graph

Sinfex + yYIBex + yy) ——

[width=0.7\textwidth,angle=-90]%
{gnuplot.pdf}
\caption{Gnuplot I2{j=}

\label{fig:gnuplot}

\end{fiqure} 1% 2: Gnuplot 1=

(float)” Zio|th. 12| B2 figureS A Al o} “Chg 1370} “g]o] 13" 2p -2 A
AFoNAE QE AL I ~\ref{fig: label}\ g B a}'?} L2 4 02 Fxalof &
ol2|&t 442 wl 2ol figure®} table2 L= A (floats)2t 1 EACE Z2E 7|

4] EATE X0l T AT here H7]1 A& AR 4= =T ©] 7] A= H(*A
o| X (HERE)o|2he= Seo|t}”) 9% 214 F4-& Alggtct.
a8E& UeHs] 289 subcaption T 7] 2|7} A|3-5H= subfigure B & AHE

=
77 37 e ATE PS5 Uk

|o

o)
fru

=

ol

ol

\begin{figure}[h]

% first subfigure

\begin{subfigure}{0.5\textwidth} % half figure for 1lst subfigure
\includegraphics[width=0.9\1inewidth]{piper.jpg}
\caption{Caption of 1st subfigure.}
\label{fig:subfigl}

\end{subfigure}

% second subfigure

\begin{subfigure}{0.5\textwidth}
\includegraphics[width=0.9\1linewidth,angle=-90]%
{gnuplot.pdf}
\caption{Caption of 2nd subfigure.}
\label{fig:subfig2}

\end{subfigure}

% whole figure

\caption{% 7§Q| subfigure& 72l figure}

\label{fig:image2}

\end{figure}

4.14.1 B9 uyc=tEId

Aol A &3] B Boke o el 2382 wrapfig H7] A & o] &350 LA 4= i},

(%29 e moir/oblivoir Ol = here
I§7|X|E AHSSHK| @=Lt
[g"xrw'}')]subcaptionﬂoﬂE subfigure,
subfloat, subfig S subfigure 7|52
H|Sote 17X 7+ 2 ULt
memoir/oblivoir0l A= Xt @E 2L
subcaptionS & == 11 O|H M7 |X|E £
S ACH

S5 rapfig22ts 17| X = et
wrapfigS 7148t Z10|CL wrapstuff™=
L&Y oSt

2roF T3S margin0fl S& 20 40|
ULCHH <marginfigure>et= 22 E

X Zst= W7 [X|7F F UACE memoir”t O]
A S TN X[ sk L1, sidenotes,
sidenotesplus, keyfloat S0| Z2 0|E2]
sE 2 ®MIBCh 7| X| 2ME &ustat

22


https://www.ctan.org/pkg/here
https://www.ctan.org/pkg/subcaption
https://www.ctan.org/pkg/wrapfig

Gruplot 3D graph

SinGex + yyNeK £ yy) ——

(a) Caption of 1st subfigure. (b) Caption of 2nd subfigure.
1% 3: = 789 subfigure S 7H figure

If you meet this guy,give him some
< money.

N TE [ U SrE A, If you meet this guy, give him some money:.

il The reason may not be clear
~\texttt{=8-)}

} — 8 _ ) to you, but I can assure that

e eral your money will end up in

good hands. I say again, if
you meet this guy, give him some money:
he knows how to use it properly. OK?

The reason may not be clear to you,
but I can assure that your money
will end up in good hands.

I say again,if you meet this guy,
give him some money: he knows how to
use it properly. OK?

oA QAHs 1S 7] $iste] & Fojok & o] 4
2o XA, Zofuj7] Zol, 17} Eolc},

2, 1%0] %9 9] (htbps}

el

T2 wrapfig| IXIXIHRE 1 v, i, 07
[Ch. 2t2t ZEhof| Tt 213, 52%% o=
F2Z0|2t= 2|0|0|C}. htbpete E2| T
FLHEHS X[ BHOF BFL.

;O

)

OI-II

4.15 Insertl>Shapes(X=3%)

PGF/TikZe 2250l =gS AT 4 A= vl A=t H7|xo|th. o=
of kg ofj Al o]t

\begin{tikzpicture}

\draw[red, thick] (-2,-1) -- (2,1);

\draw[green,thick] (-2,1) -- (2,-1);

\draw[blue,ultra thick] (0,0) circle
(1cm) node{\huge \LaTeX};

\end{tikzpicture}

olfd 3ot A ol Qo] A= AT AS T 4 Uth. TikZ.net= Hwal et

THFWYSIWYG 2138 18]7] =2 730] H @5t Inkscape(https: //inkscape.
org)E FXetth. o] Z2 a2 KIEX S Attt & AT ElAE O /5 KIREX 4
oz g4l

Inkscape & A 8stal A F3t E2 =2 17 tF5 M FollA] Extensions/Text/For-
mula (pdflate)...o]} Extensions/Render/Mathematics/LaTeX (pdflatex)...& Al Ei5}od

4.15 INSERT[>SHAPES(=%) 23


https://github.com/pgf-tikz/pgf
https://tikz.net
https://inkscape.org
https://inkscape.org

LaTeX input:l\LaTe)({} math: Se ~ {i\pi}-1 =09 ‘

Additional packages (comma—separated}:[ ‘

[ ] Live preview

Close Apply

Eile Edit View Layer Object Path Text Filters Extensions Help
Do &8 3aE| - 0OY B @aa oa®l v
o @ iE o5 B 7| x[e2sos [J v[essassfy v
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£ 1 T*I]:Xmat T ] ==
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Oz _
0
® - shapes
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g >
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© ] normal text LN
as
: -
e - !
AI T 3
> -[<| | m | \)]H ’
XEEEEEENT = EEE NV —m—
i [>]
Etll-;,ke; Unset O - L) [L] Group oflob|e¢ g;i ;g z:

a3 5: KIEX o] YA ZiAl o] |

2B+ 2 JiA 2 23tE = B estohy 2 sol|A] B Hhet
2= ot &4 E 192 PDF, PNG 5 KIgXo] A|¢st= Toio 2 Y

r-‘i
n{tl
i)
1o
I
o
o
Z,
oXx
ol
N
do
:oé
e
Y
i
[
&

« GLE (Grahics Layout Engine)+ S 8
o A3 g dojojr}, [...] GLE+= ILEHEQ} Y &9 HAE 9 £4] 283 KX
of| o]&3s}aL Itk https://glx.sourceforge.io/

24


https://glx.sourceforge.io/

« Asymptote+ 7t Hlg 12fd 7]& dojolt}. HAYZAT =& & 12)7] &
AAAe] g 27 7R Y Y-S A Fehet. epilaf 24 S WX o2 T EST
https://asymptote.sourceforge.net/

« LaTeXDraw+ BIEX 2 9Ig 18 HYY 7|0}
https://latexdraw.sourceforge.net/

+ Graphvizi= ZHet EIAE Qloj 2 O x5 7| &l BIgXoll 23t tholo] a3
BHETH
https://graphviz.org.

o)2 W71 A 5 o] &3 BIEX S 913 2% EW0| £4 1S A2 5 AUck. ool =

@t} “LaTeX vector graphics” = & A sl e},
a8 £ A= =79 FF+= o8] 7kA7F Aot TgX Showcase 30| 2] & s 2 H
Z0]2 (T3 oj2] o2 WAL 4 UL Aoltt.

https://www.tug.org/texshowcase/.

4.16 Insert>Page(@|°]A])

B PDF H|0| 2| overfull 2] ¥ & Wz] &2 B2 AAshe 22 pdfpages 7| xS
2t g}, oh5a 22 A o = ARgsit,

\includepdf[fitpaper, frame]{pandoc template.pdf}

o] &L 2.480)|A H?l Pandoc O 2 THE50] A= PDF #A1 S A4t TS Ho] A
= 9ol Fr 2 AYst Ax} A E PDFE \includepdf3at Zx}o]ct,
pdfpages+ ©|qtoll= o] 7}A] 7|55 Z+3a Qloy mj7]| ] EAE Slo]E & o]

4.17 Insert>Rule(FA)

2do]o] Zolot £7E 7HA = He \rule BP0 AL},

This is a page-wide

rule:\\ This is a page-wide rule:
\rule{\linewidth}{1pt}
but this one is shorter but this one is shorter and thicker:
and thicker:\\ I

\rule{2cm}{2mm}

wsh oz 2oz HAS 2= \dotfill Hgo] Ut {3t AL AZAT

wj &3] &t

Total price \dotfill \euro~10 Total price ................ €10

o
=

L EEZE

3 overfull 2 ‘0|24’ 7t 0

Ax|ot=

4.16 INSERT[>PAGE(H|O|X|)
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https://asymptote.sourceforge.net/
https://latexdraw.sourceforge.net/
https://graphviz.org
https://www.tug.org/texshowcase/
https://www.ctan.org/pkg/pdfpage

This is the title:
now write the rest

Guido Gonzato

January 2018

Abstract
This is the abstract.
Contents
Section 1
Subsection . . . . . . . . 1
The End 1
Section

This is bold text, this is emphasized text, this is normal text. If you're bored,
go to The End.

Subsection

This is verbatim text.

The End

My dad used to say:
Damn, Pandoc has not been invented yet!

but not it has.



4.18 Insertl>Hyperlink(slo]&®3)

hyperref 1]7] 2] = URL @ @] #xo] 32 wt5o] PDF7} BeteA 7H556HA o
£}, o|E 51 o] A= o2} o] AAsgith

\usepackage[colorlinks,
urlcolor=blue,
filecolor=magenta,
linkcolor=darkred,
hyperfootnotes=false]{hyperref}

g o=

\urlstyle{same}

The \hypertarget{ctan}{CTAN} main site
is \url{https://www.ctan.org},a.k.a
\href{https://www.ctan.org}{CTAN://}.

Listen to \href{run:midifile.mid}
{this MIDI file}.

Click \hyperlink{ctan}{here} to go
back to the top.

The CTAN main site is https://www.ctan.org, a.k.a CTAN://.
Listen to this MIDI file.
Click here to go back to the top.

ZIEHoz \url g2 IHE FEE AT 2ESR Z
T B3-S \hyperref 41¢l o] Foj

rlo
uj
U
o
[%
kl
B>
o
g2

\urlstyle{same}

7]%% PDF 2] tjol w}e} 2] ¢ o] 5]7(] ore 2 9t}
hyperref Sj7] 2] 241 Z Qjoj B2}, o @

4.19 Insertl>Comment(F4])

FAHES HEHYE %5 7 49| dof] Eo]AY comment 37| X7} A|-8-5F+= \comment,

\endcomment H& I} comment 742 &t}

This text % boring example

\begin{comment}

what a boring example This text is just an example.
\end{comment}

is just an example.

2 FO{A URL F2E
o HAES 7

MLE-H, [l s

. G2k 2| o] offFIof M=
.

™
o
nio
it (U
%
ot
Ot
=%}
o

[g‘?y’]memoir/obhvonroﬂ)\‘l IHHo =2
<comment> A2 HSTICH
\commentson, \commentsoff HHOZ
0|8 20|ALI &4 == ULt

4.18 INSERT>HYPERLINK(3}0|m{2!3)
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https://www.ctan.org/pkg/hyperref
https://www.ctan.org
https://www.ctan.org
https://www.ctan.org/pkg/comment

PDF &3 &0 Y LEA o 45 £0]7] a4 pdfcomment 7| A& AH
=}, o] ShjA ol A= th2 3} Zho] A Q15 T, o2l PDF F4A]& 2ol oS B

[icon=note,color={1 1 0}]{pdfcomment}

This text is nothing special
\pdfmargincomment{yup,definitely.},
but it contains a couple of
\pdfmarkupcomment{nice}% tains a couple of nice comments.
{simple,more than nice} comments.

This text is nothing special, but it con-

PDF ¢ %42] 79 PDF Holol uet (At g 397} &S opea,

5 Format Y%

dutA oz FA9] 7|2 mHf &£/d& HAA5t7] /s = \documentclass H 9| A=
Hojghth, AT 4 A= sz 7|18 & 271(10, 11, 12pt), 2] (adpaper, a5paper,
b5paper, letterpaper, legalpaper, executivepaper), 8% (portrait, landscape) 22 Z°|

At

\documentclass[a5paper, landscape, 12pt]{article}

EE 37]of thd}te] 5.2.3 0] o] AHA|5] =52

5.1 Format[>Line Spacing(3} 7+3)

setspace I 7| A= <singlespace>, <onehalfspace>, <doublespace> ¥73& A|&3tct. 1

23 \spacing{amount} B3 (373) o2 Jo|| & 747 ZrS A 4}, ¥
[ =}H \singlespacing, \doublespacing, \onehalfspacing2 H&ol1l, <single-
space>, <doublespace>, <onehalfspace>= 7golth. A2Jo] 2 M= <spacing>
< ...ing2 & BUA|Rt g7o|tt. o] PEje AR = 1 FHo] FEEojoF a7t
Upehdet.

\begin{spacing}{2.5} These two lines
These two lines \\

are crazily spaced! .
y sp are crazily spaced!

\end{spacing}

\begin{spacing}{1}

Much better,these lines\\ Much better, these lines
are spaced normally. are spaced normally.
\end{spacing}

A Ao AA Y 2kAZ De] 475k \linespread{factor} ¥
of = =t} factor? 7] =gk 10]ch. % o] Zro] #HX|H 3 Ato] <] ZH
N7k thek 1.6 J=9 ghol Bt

T
)
H1
BL o
)
R}

[g‘?%]pdfcommentf XgIEX 2 K[ SHX[2t
A2 4201 M 1ot soul 2t THF|X|
soulposE 0| 7| X| 7} &&3}7| wiZ0f
ulem2 M= MO SA| A7HO| ELX|7}
U2 == UL pdfmarginpar2t= ZHHS
IHZ|X|7F U2LE pdflatex Bt & TF 5f0
H|2:3t 7|58 2HE todonotes = ATHE 4=
ALk

[HZF+37]

memoir/oblivoir0i A= setspace S
HE 2 2L 0t (R 2XHE HZ2ALE
H#) 22 2tEat EHEE A8Y =+ QUL
o|Z4tH \singlespacing®ll CiE3sH=
\SingleSpacing BHO| U1 <spacing>
CHAl <Spacing>E A H E[= AlO|C},

3 51201 2 A= CHH| 2 27122 9|

= 20| ATt koTpx H122| 17| X| S0
] 842 70 K2 13 HE Y

2t XS oblivoire 29 E2

0
r
|

T RIETZ MM 7| 160201 7tIt2 B2

FORMAT 0|57


https://www.ctan.org/pkg/pdfcomment


yup, definitely.



simple, more than nice

https://www.ctan.org/pkg/setspace

5.2 Format[>Character(ZA 2%)

E L = o O%
QA E = ZE o] AR 37|+ documentclassol] F-o1H 712 37](10, 11 £+ 12pt)°fl uf2t
gehzich ® 62 Bt
22t 4§74 B9 &7 oA
\textnormal textnormal main document font
\textrm rmfamily roman
\textit itshape italics
\emph n/a emphasis
\textmd mdseries medium weight (default)
\textbf bfseries boldface
\textup upshape upright (default)
\textsl slshape slanted
\textsf sffamily sans serif
\textsc scshape SMALL CAPS
\texttt ttfamily typewriter
\underline underline  underline
\textsuperscript n/a this is superscript
\mathrm n/a X" + y" # z2"Vn # 2
\mathbf n/a x" + y" #£ 2"Vn #£ 2
\mathsf n/a X"+ y" #£ 2"Vn #£ 2
\mathtt n/a X" 4+ y" £ z2"Vn #£ 2
\mathit n/a X'+ Yy £ 2"Vn#£ 2
\mathnormal n/a x4yt # 2"n F# 2
\mathcal n/a XN L YN £ ZNYN +£ 2

E4. ZAEY

71221 A A (italics) 2 7+ 2 A (emphasized) 2] xto]ol] thsl -f-@siof strt. o3 ol &2
EHH \emphdt FEo] HtZ2 A AMA| 2 = o] Y& & 4 Aot o]et Zo] \emph+ AA]<]

Efol el & A Yot FYol ot =2/ Fg er PPl ol ¥
\textit{For example,this portion
— of text is typeset in For example, this portion of text is
< italics,and \emph{these typeset in italics, and these words
< words} are emphasised in are emphasised in upright.
— upright}.
w3tk

obelAHs 424 BEC| AR ALg BHE Zo] UnkAolc}, BE HAE AHE3)e]
95)]\

this is
$ {\mbox{\footnotesize%
{subscript}}}$

this is subscript

FF g BMoj|M 0] =o)X PxE
O 7| TiEt 2101710 Y2 BEL QiCt
ET WO A= TN 2 B2 ML
TEHE Béists 248 MSsts S3tot, of
OHHAl Ol =0 A= o EMO R QAN 2
7120|1 AHS W (X2 It BHS
HESH| QA= UBIE O 2 BHtSofX| =

J

19
>
0
ry
N
N
jac}
[}
i
fivas

H
Rl

X
=2
>z
H
N
rr

OfHYHCE YX ESHS 2 AR
UM ALk 2 2

[g‘$'4o]o|a.|5‘_+ E2|2 MX| 9T
\textsubscript §HS E9
Bl AEOf Of2fHAIE Mg 4= ULt
\textsuperscript = OFEH7HX],

5.2 FORMAT[>CHARACTER(ZAt 2¢)
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ZE 37 | A]

tlny sample text

scriptsize sample text

footnotesize sample text

small sample text

normalsize sample text

large sample text

Large sample text

LARGE sample text

huge sample text

Huge sample text
X5 EZE 37

Default font size 10pt 11pt  12pt

tiny 5 6 6

scriptsize 7 8 8

footnotesize 8 9 10

small 9 10 10.95

normalsize 10 10.95 12

large 12 12 144

Large 144 144  17.28

LARGE 17.2  17.28 20.74

huge 20.7  20.74 24.88

Huge 24.8 2488 24.88

)
L
3
>
(@]
>
[¢]
L)
\y

Tojx] dsto] ~ok & A Atet ofeiH AL E AlAket 4 Qlr. 1
m 7] 2| & o] &35} ¢ 7tAsit}, A= HEZ ol H A= Sof7}
theoll 2= AL AHAZ Aafgtet. vHSA12 \ce HH 9| QA= Yjic),

~HS

\ce{H20 + C02 -> H2CO3}\\
\ce{CaC03 -> Ca"2+ +

— €0372-1\\
\ce{C03"2- + H2C03 -> 2
— HCO3"-F\\

\ce{CaC03 + H2C03 -> Ca™2+ +
— 2 HCO03"-}

HzO + COZ — H2C03

CaCO3 — CElzJr + CO32_

CO4%™ + H,CO3 — 2HCO,"
CaCO; + H,CO; — Ca** +2HCO;~

H] =5t 248 LA chemformula 3 7] A = Qlch.

=
= UZ o] W 7] AEFAS S| HF U koTex 17| K| S04 A luatexko= KHA|

ulemF BH S MIICE XgTEXO[Lt
pdflatexO[2tH ulemS EE 2 2E3ICE

U= 27| = 2] g Zo] dRbdolt}, o] AL

O8A 27 EA & Gt} dgo|x B W& HlT A
2 ek 4 ok o Alof| A o] 37| x| 7} A -5}

Halct.
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https://www.ctan.org/pkg/mhchem
https://www.ctan.org/pkg/chemformula
https://www.ctan.org/pkg/ulem

\uline{important}

\uuline{urgent} .

\uwave{boat} important urgent boat wreng

\sout{wrong} tetndied

\xout{removed}

ulem E’H;,]Z]% ’%}?j_ %io] E‘.Eﬁ]"l‘ \emph EF]E:] o ZHX—]_‘]OI_O:] O] EH ‘_]_ ‘?.:]% %7]5&
BHEC}, o] 218 w5t thg ot o] 3MS Rostet. 4 S5y lem Tt AR 7|52 HZSHE sou

17| X|= QLI EL SOFA|OF 2Xt2 &

\usepackage[normalem] {ulem} A8 At TS Bl sciatin

lualatexOllAl= 0| & AFESHA| &*tﬂ
5.2.3 Format[>Character Size(Z 24})
BIEX o] BE Alo] 22 Z 8 2] gt extsizes T 7| A7} =0 € Zolth, BF A S
22 3A50], 8-12EQNE | 14, 17, 20 EQJE SA L 2712 Hold 4 914 53t}
of At 22 17pt articles 235t Stohar s E2F, 12 oh-33k o] A|2betH
Hh

\documentclass[17pt]{extarticle}

2 28 Y o Y2 typelem W] A E o] &3k Aol ok &2 ol
L gsjRc} 43 (53] typelcme= 222 typel CM2ZE
Ihgote 710/0f ERloil M 2j0|7t QICt.
. AthHQl 2 ZEIY ZES AH8 0= TX
\fontsize{72pt}{72pt}\selectfont QIZIO| A= O] IHF|X| S1O| &= Of| |7} K| Al St
No Smoking FHO oot AWE Ag 4 UL

—

(o] ollAe] Az o] ZFAfoll EAISHZ ol U A7) wiZoll A} AAIE FFsiet) &+
QNAp= 2H7F EE 7|8} Ho] Akl () o] Zololtt.
wotE Haupy o & of g3t 7ol sk 4 Qo (%44 ob i A7H3t adjustbox Ol

\resizebox 2t OFE7EX| 2 EfA XM E
stoliste BEO0| Hol=[of /UL 222 o2t

T

A2 AddS SIEE ot YR
\resizebox{!'}{1lcm}{1l-cm tall} - \adjustbox{height=1cm}{1-cm
tall}OlC}.

g e S 2 A2 AASH= lettrine 2 lettrine T 7] A 2] \lettrine §H S o] &
gt} ol2] 71A) AL RIS} 7hs 3t o] Eaboll A el AL the ) o) 7] Bk
I 2 Zo|ct,

\lettrine{D}{ropped} capitals at

< the DROPPED capitals at the start of
start of a paragraph can be a paragraph can be obtained
obtained using the lettrine using the lettrine package,

— package,

5.2.4 Format[>Character Font(ZE

BEX2 Y2 S22 Q0 ZE A|AHRS 72T Q13 7| 232 Computer Modern ©] T},
METAFONT A EA|AELS 53| H o g mnitt 23§ TES 2502 A/ttt o|F

5.2 FORMAT[>CHARACTER(ZX 22 31


https://www.ctan.org/pkg/extsizes
https://www.ctan.org/pkg/type1cm
https://www.ctan.org/pkg?lettrine

oz of FRoM e AT 2 S Bt FE 2HE ST 4 AT Y
$-2]+= &2, Times, Helvetica, Sans Serif & T2 Z72] ZEo| 2% A Qlct.
thad 3], BIEX A7 PostscripT Type 13 @ ZEFQ] OTF ZES &85 4= ek

avant, anangar, bookman, chancery, chanter, courier, helvet, helvetic, ncntrsbk,

newcent, palatcm, palatino, pifont, times, utopia, zapfchans-°] Type 1 ZEE &

23 o] 2835 4~ Q1= wj7] A 50|t} \usepackage{times} S Ze|YLEoj Zojgom

2 T MR
oG E=A] Zels Ha}. o] A= libertine T7] A& ©]-&-5F3iTt.

Chek, 4]S o2 wjoll= Computer Modern EE S #|-835}= Zlo] 2 Aojgte Ao
Sol5}zt. T2 ZE S AF851H 48H4]o] Y7t o] A E AnE A 2o}

FUIZER EFER, LEE] EES A Yot xelatex2 A2 2ot & 4= =
o] AH A Zotzltt. LaTeX Font Catalogue YAFO| EE HhEoto] o EET} Jl=%]
i) =it

AollA AFE 7| A 52 24 Ao EEE HASH= Zoltt. ofte] BlAEofgh
£ EEE A -&3te i o2 oAloll A Eol= 2| font family & A siE . &3]
2:0] = font family S E 70l 2 ks FAch. B font shape 7t L Eol| A& A =] 7] g
& AtHe AMA S dobRat. 10

This is Computer Modern Roman,
{\fontfamily{phv}\selectfont
this is Helvetica!}

[FAH GFolA AFeH HZ 99 clA| & XqTEX o2 ZHutdshs H g 2ofA& A A
2=t I Al ok |9k o] stofof st} Latin Modern©]2H CMolA] & 2 ZE}Q] :EL

L 2X Xg¥TEX 9] 7] ZE 0|4l TeX Gyre Heros= Helvetica®ll th-5-5H= TeX Gyre 2%
(2Ees))oltt. EE JHE 95l fontspecs ZE3oF 5h=t] pdflatexZ ©] 7] 2=

L =1
A QehA| =

\fontspec%
{lmromanl0-regular.otf}%

This is Latin Modern

<~ Roman,

{\fontspec%
{texgyreheros-regular.otf}%
this is Heros!}

This is Latin Modern Roman, this
is Heros!

5.2.5 Format[>Character Colour(Z*} A4

color B xcolor 7] A2} &l ifejo g Fxjof| M-S Y 4

white, red, green, blue, cyan, magenta, yellow 7} % 2] & o]
o] Aojgt 4= ik,

BashA S 2

9t} 7122 0 2 black,

SFelze my|xe faye HotYsts
QUEION I A| ZLEICE O] EHEf2 =2
pdflatexO| ZIH AIEIQN Aol MLt
Folojsict, HAEE xelatexS 01850
Aot st=g| o| mf o|2 mi7|X|= 2|a| 7t
AL FOfM ArZsHiOF BT}, T 1=
libertine I§7| X|:= pdflatext xelatexOll A{
DF FESHA SEfetct.

(57461 0| 2etof| A LSH= font family, font
shape S2 pdflatex AIZEI0| M M0|= EE
e A A”o] Bojolch, QLIBE ZES
st ATl A= 0] BH2tol L0
MEE|X| =0t H 7= OFEIEX|CH

[

(%9 n|2| Ho|El AMAHE S xcolor 7t
CHISHA M3t A} 2H latexcolors,
ninecolors S M4 H2|E NS dt=
I§7|X| S0] QUCH.

A
(=}
=)
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https://tug.org/FontCatalogue
https://www.ctan.org/pkg/color
https://www.ctan.org/pkg/xcolor

_%Ejmmgl ™ 2]

Al

= [oRde]
cmr Computer Modern Roman
cmss Computer Modern Sans Serif
cmtt Computer Modern Typewriter
pag Avantgarde
pbk Bookman
phv Helvetica
pnc New Century Schoolbook
ppl Palatino
ptm Times
pcr Courier

Bl

7: A5 2ol= ZE 1l g (pdflatex)

\textcolor{red}{This is red.}\\
\color{blue}

This text is blue!\\

So is this. Let's change.\\
\definecolor{mygreen}

This is red.
This text is blue!

{rgb}{0.1,1,0.1} So is this. Let’s change.
\color{mygreen}

This is my shade of green!\\ A cyan box

\color{black} A green box in a blue frame

\colorbox{cyan}{A cyan box}\\
\fcolorbox{blue}{green}
{A green box in a blue frame}

L
0
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N
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-
o
o
Q
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o
P
o
S
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rlr
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o
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rlr
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N
2
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ol
rlr
o4,
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o
3
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5.2.6 Format[>Character Outline(®Z4 2A})

Aol M-S 5] = Znto 2 FE %] &tthH contour T7| A S o] &30 824l (9] ZA)
22+ THEo] B2t \contour B2 2AHE 16W (B A5t A4ntE) AA4 Hof
LA g whEol i EF sz Mg Ec HEee

\contourlength{0.5pt}

\Large

\textcolor{blue}{\contour{red}

{Blue text,thin red outline}} Bluetext,thinredoutlme
\contourlength{2pt} mm&mmm
\textcolor{white}

— {\contour[32]{blue}

{White text,thick blue outline}}

5.3 Format[>Paragraph(¥% 2 %)

- - ~ l%l— O
TES\\U R 22 2= gAE0 AR 2 A T PEl= BIpXel +d5te A™d=S 8715t yxsicai sy 2

£H2 2 E0|Lt\par2
2}, e AS LT\ E B o 2
Lol M2l 2| EBHE0|CH
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https://www.ctan.org/pkg/contour

24 A

abstract Qorz

array PR

center 7ted 4=

description ARy g AE

displaymath el 2o (displayed) 4]
document A AAE e 24
enumerate HoH ZAE

equation H3) 2ok (displayed) 425H] (A FHH
figure wrhy s 1Y

flushleft A& HY

flushright EZ Y

itemize HSHFGAE

letter 2| &4

list 714 8] AE 37

math 3= (In-line) 4~4]

minipage o] vjzo] 2

picture YAE AT, A, U 59 5
quotation oz T AEE(H = =927 AS)
quote S IR (A & 59127] 8lR)
tabbing HAES o]l g5t HY

table Houes &

tabular B3 Az A YAE
thebibliography &3 55 2|AE

theorem A, HA 5

titlepage TEAA] 2

verbatim AHE & Ho|7]

verse Aot &8

24 oAt A Hwlolu ZE o 58 Holsly| 95
Opx] 0f2AZ BHIAE JHE MEefsho]
S MES ZeUske AT RAIT, FREE gaE

\begin{environment}
...text goes here...
\end{environment}

ol & SojEx},

e
Mo

& 7hetl JE5H7| 2 5FH <center> 735 &35}

\begin{center}
this text is centered
\end{center}

this text is centered

7

o

==
N
ot

= gol| 2okal i}, ofl 1L A& WS B 7HA] Koz}
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5.3.1 Paragraph[>Horizontal Alignment(3¥)

7|20 R Fu2 FEUFORE FHsth, X% JHo|lu LEX A
JE-2 <flushleft>, <flushright>, <center> ¥7 ¢to| HAEE Y=}
\raggedright, \raggedleft, \centering©o] o] &4} z}7} F-AtS
5 AR M2 o] AlASE7| M7kR = R 7F UERA] =T

5.3.2 Paragraph[>Vertical Alignment(2% Ato]2] )

Bk 1R BEX S WAlo] 9= TR AIA AFE RS o] PEete Hevt 2E Uk, v
Zo|U} Fuo] of] 7} o} sLfo] Bl Z, sHfo] Fuj O ZHEHY, webA Wl < ol
N k3 84 Bk Abo] 7} o Wojx) & Zlo] ohuebi Trolc}, \smallskip, \medskip,
\bigskipolgt= H3g 2ok Atojo]l HA|Z o2 Hojglojof Bkl Bk Ato]o] Al
1=
o|Hr} ] 7+ALS ¥ Atk \vskipS TS H 7]} ZHo] Hojd o ) 50 (H550\ yskip2 TeX H-O| T \vspace=

BTEX EHOICE =5 \vspaceS 4= X0|
Ol K| ob2 o215 WA 4= QUCH \vskip

These paragraphs will be sepa- 2 ofAloilMet Zo] Zalghke O Fof M,
rated by 1.3 cm: \vspace:= ZO0|E ZZTE S2{MA

These paragraphs will be
separated by 1.3 cm:\\

\vskip 1.3cm

there is a 1.3 cm gap above me.

QX2 HEet,

there is a 1.3 cm gap above me.

\vskip& Q& Rk Afolo| Mgt FAgTE, MZE ol x|o] kol (5 ol o] B
o] ghi= Aefell ) T 1.5cme] B £ 2The AlAkska Ak o} @ shof &7t

\nullg (gl 25 thal) ‘B2’ 2 4o} 7HA4 & A sfjof gt} ™! U iex 9l \vspace B0l HEES
=0 Al \vspace* YA OE MH HHO|
01Tl 2|X] O|F (3 o|=2)0l| 7|& 2EHo|
SO 7 7tA S HE|T| 20| 2201 A
\null HIESIL e Aot LS 2 RHELE = ALK
\vskip 1.3 cm

This text comes after 1.3 cm...

[¢)

This text comes after 1.3 cm...

O A\vfill BFo] ot & 2 ARl E Ml 0B A9 H ARSI S F
WA 2o g4 1 o] 29 vigto] 94 Hck. the o& wata),

This appears at the top of This appears at the top of the page...

the page{\ldots}

\vfill

{\ldots}and this at the

= botton. ...and this at the bottom.
5.3.3 Paragraph[>Margins(Z% %)
25004 2 v}, B T2 A WAlo] A s Zolth, o HMo|T BT Eg w7
Sk Ae Ao R 5l 8Ex rr) o Boe) B B2 WE e Al dow og
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\newenvironment{margins}[2]
{

\begin{list}{} {
\setlength{\leftmargin}{#1}
\setlength{\rightmargin}{#2}

} \item }

{\end{list}}

o o] Helet $& ket 2ol AHgITE

(752 0] oMM E M2 s
Holst A1 =8, memoir 0|

As you can see,this paragraph
has normal margins.
\begin{margins}{0.5cm}{1lcm}
But please note that this
paragraph has custom margins.
\end{margins}

normal margins.

But please note that this
paragraph has custom
margins.

As you can see, this paragraph has

<adjustwidth>2H= &40 0| 7|53t H9|
KAt A2 MSeth memoir2| 22
changepage T 7| X[ (0 T 0| S 2
chngpage) 2| 22t SYSiCE.

5.3.4 Paragraph[>Indentation(E°%27])

9 A & 5927]9 2715 Ast2¥ \parindentah= o] H49]

g el a,
03 B7]= E927]5 1emE s+ Zo|th
\setlength{\parindent}{lcm}
\indent®} \noindent P 1 thZol] 2= EH9| S0 7|5 Aot
B2 2 \parskip Zo| stetu] e 2 £ Alo]o] ZHA S 2| Q5= 4 k.
\setlength{\parskip}{3pt}
5.3.5 Paragraph[>Border and Shade(Z&|Y43} Z%9)
2o thojof] |2 x|& b framed M 7| A& £t} T+ \parbox B 2
8511 ==t o] wj calc 7] A7} D Q 8},

47 framed & ©]-&5h= of| & Ho|A},

\setlength{\FrameRule}{2pt}
\setlength{\FrameSep}{5pt}
\begin{framed}

this is a framed paragraph!
\end{framed}

this is a framed paragraph!

\definecolor{shadecolor}{rgb}
{0.9,0.8,1}
\begin{shaded}
this is a shaded paragraph,
do you like it?
\end{shaded}

like it?

this is a shaded paragraph, do you

BFlnet, o5 s
SAxE 2t Atool Y3t
=

H
m
rot

O = = =
Meu, ZMZ el &2
Zi0| otL|zh= d F2ofstz]
HFE SHCHH parskip
Z30] =ct,

oA mjo

[HZF*54]

memoir/oblivoir Ol A= framed
I7|X9] =2 7|58 AHM| 2151 QT
SHH I Bl AE 160 QU0 A=
2rot 17X 2 adjustbox, efbox 2/0f|
tcolorboxE BHEA| g8 =21 stct. O]
AE 7| X = WA|BH A E T2 =
Ao AN HRot HO| R RS 7|5
XS stct,
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https://www.ctan.org/pkg/framed
https://www.ctan.org/pkg/calc

18] a1 boxedminipage 37|27} QlHl, &2 o529 #4 2 & 4 WA k. =&
JES FAH oh T 22 WS Wel= A2 AMA <boxedminipage> 732 2= AT
sttt

\framebox{

\begin{minipage}[c]{\linewidth}
text to be framed

\end{minipage}

}

\width |22+ AF= Foj 2= Pl A E 9] Y-8 T2 minipage 2] A SlgHE 714 1L
At S 3ot E435H 2ol & A s = Al

Foi7] el AEo] Guks Zojo] mejele TR A}

this is a

\framebox[\width]{framed} this is a word

word

this is another

\framebox[2\width][r]{framed} this is another
word word
ik B ’LO]X}%E 1 Qo] Ul-go] s ulo] FE ®HAlS ARttt o] B7]ollA=

5.3.6 Paragraph[>Colour(Z&% A4})

2ol meo) oy of 4] AE AAskn Aok, oA st

1o
=

\colorbox{yellow}{
\begin{minipage}
{0.8\1linewidth}

I am a minipage,my
— colour

is yellow!
\end{minipage}

I am a minipage, my colour is yel-
low!

A Aol A E=Z0] minipage®t 1 A2 3 LH] 9] 80% T A &EH =5 A3l

Aol cfsto] o AHF LG 5259 FTskeL.

5.3.7 Format[>Columns(tth)

\twocolumn®} \onecolumn - N ZL Ho|x & &

\documentclass?| A ue}n| g2 AT L=}, 0]7/1 2 Z283] 2thH multicol BF5 2122 m47|X| 0|28 multicols2tD
ol oIl ol ol & a0 st gl Mz zomr Bt27| SRt
1 7| X7} A58 <multicols> 73 0] lth. o] & o] &5}o o] Ho] &S ojdto 2 2t ARSACE multicol Q] ZA S b :)\|
= 30 o8 slole *55 MZ2 H|O|X|Z A|ZtSHX| QtotE ElCH=
o]'_l_xl' Mr’l‘uxj l:]‘ux']'_;l':: OI—ME 7}10]]:]‘. AT et EAES HS -’F%\HL xjo|c}.
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https://www.ctan.org/pkg/boxedminipage
https://www.ctan.org/pkg/multicol

\columnseprule=1pt
\begin{multicols}{2}[\subsection{\entry{Format}{Columns}}]
The commands \cmd{twocolumn} ...

\end{multicols}

o Ato] o] 7HA -2 \ columnsep Zo] ¥4=2 Aojstth \columnseprule j3 2L o
Atololl oAl &= Alo) #7158 e B S 2 8L JH A HAEL O B4 S
AlZFst7] Zofl sl #79] FFS WA s 2she FEoltt

6 Table W&

AL (2-7F) ol 24 AS gt o] Fst FAIE of 7] e Bt

o]0 X (image)7} figure9t= Th2 A3t uF7IR| 2, <tabular> 3747} Z (table) = N 2
2o} BIEXS] tableo]t 21 WUl = 74 (4.1478 0l A A W) 24 gt 0] 2] & Fo7}t
A k= Zlojojof gttt S D 4 A A2 <tabular> 7 1 Qtof] 23T
<tabular>= EH3 FHO & JZsljof sh=t| o] AsAlrt.

7)1 BTEX tabular 714)= the-} 7o) % ojstet,

\begin{tabular}{|l|c r|}
% zl_z ZC&)}- Oz 1—131
% 9*%.*% 3, 1I§_%
1IE%% HE D|E0[A SHCt

\hline % =1 M one | two three
a& &c\\ % FHH A

one & two & three \\

\hline

\end{tabular}

oA7|M =2 A, A, Ao 5 AT AS & 4 o}, tabular?] St 32 &0l 95t
EEH A =2 o|F o,
booktabs T{7| 2] & o] &3lH N 2&0] gt o MHY ZFS 2= tabulars 18

gic.

\begin{tabular}{lcr}
\toprule
1&2&3\\
\midrule

a& &c)\\ a c
one & two & three \\ one two three
\bottomrule

\end{tabular}

1 2 3

CH3oll Hol= A oAl tabular 741 S Zofd et WS Y

gt

o},

[AZF+57]

memoir/oblivoir= booktabsS
J|=oz Zejselrt.

38

TABLE 0| =


https://www.ctan.org/pkg/booktabs

% 48 H; AZR/SY/REE ¥E; 1¥
\begin{tabular}{lc|rp{4cm}|}
\hline % =g
\textbf{Left} & \textbf{Centre} & \textbf{Right} &
\textbf{4 cm}\\ \hline

row 1,col 1 & row 1,col 2 & row 1,col 3 & row 1,col 4\\
\cline{1-2} % 1-2 ZEO| MM

row 2,col 1 & row 2,col 2 & row 2,col 3 & row 2,col 4\\
\cline{1-2}

\multicolumn{2}{|c|}{spanning two columns} & row 3,col 3 &
row 3,col 4\\

\cline{1-3}

row 4,col 1 & row 4,col 2 & row 4,col 3 & ~ \hfill right\\
s ~0f| o3 2|2t

row 5,col 1 & row 5,col 2 & row 5,col 3 & left \hfill ~\\
row 5,col 1 & row 5,col 2 & row 5,col 3 &

~ \hfill centre \hfill ~\\

\hline

\end{tabular}

I

Left Centre Right 4cm

row1l,coll rowl,col2 | rowl,col3 rowl,col4

row2,coll row2,col2 | row2,col3 row 2, col4

spanning two columns row 3,col3 row 3, col 4

row 4,coll row4,col2 | row 4, col 3 right

row5,coll row5,col2 | row5,col3 left

row 5,coll row5,col2 | row 5, col 3 centre

tabularray

o] 242 a7} Z71et}t, = E (tabular) = 2 SS9 KX AFEALS 1 &5 2 EA4A
ohget @ ek A7of S5k £, Hi7| A S0 hZ o 2H iR o] o 717t Ad 755t
Al = Aot YR g2 a2 A ool 23] Folo] o] Ql=A] &7 o2 A7t = ATt
tabularray+= EEE J2)= 0% Zstal F84 Q1 wj7] 2 o]t} o] RhA & E7}5to]
T 3ol tfste] Agshe EA0A A 7I5Hs A Q] B2 7]5& key=value TS °]§
sto] &gt 4 Qlok. Wit v oA Yot 2 2S5 YUS Aol
QJol| A A1E BE tabularray 2 <iblr>2 2] ol & Bo|Zth,

\begin{tblr}{
colspec={Q[l]Q[clQ[r]Q[4cm, 1]},
hline{1l,Z}={.8pt},hline{2}={.6pt},
vline{3}={.4pt},
vline{3}={4}{dashed}
}
\SetRow{font=\bfseries, fg=olive5} Left & Center & Right & 4cm \\
row 1,col 1 & row 1,col 2 & row 1,col 3 & row 1,col 4\\ \cline{l1l-2}
row 2,col 1 & row 2,col 2 & row 2,col 3 & row 2,col 4\\
\cline[dashed]{1-2}\rline[dashed]{4}

TABLE 0%
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\SetCell[c=2]{bg=gray!30,c} spanning two columns & row 3,col 3 & row
— 3,col 4\\ \cline[dashed]{1-2}\cline{3}

row 4,col 1 & row 4,col 2 & row 4,
row 5,col 1 & row 5,col 2 & row 5,
row 5,col 1 & row 5,col 2 & row 5,

col 3 & \SetCell{r} right\\
col 3 & left \\
col 3 & \SetCell{c} centre\\

\end{tblr}
Left Center Right 4cm
rowl,coll rowl,col2 | rowl,col3 row1,col4
row 2,coll  row2,col2 | row2,col3 row 2, col4
| spanning two columns | row 3, col 4
“rowd,col1 row4,col2 | row4,col 3 right
row5,coll  row5,col2 | row5,col3 left
row5,coll  row5,col2 | row 5, col 3 centre

tabular7} U5 Z o] A 3l Ho] 7] ¢toj
0]-g-5tof of2] Hoj ol A=
7] 2| = <sideways>2h= BH S
EAZZ gAY 401 A Zhz ok 5| A A2
tabularx 7| A= To] YH|E THZ O
ZAY S A Fol EHo]—011 AtjA ol Zo] & Y
Th&=2 | Alo| .

S017kA] ¢= w7t ek, longtable si7]1 A&
tabular& 2/dst= Z o] 3t 7}A] ¥ oltt, $HH rotating
A Z-5h=t] o] & ©]-8-51 tabular A A (= cell 5tL})

/\OE}

2 A4 5 YT X DY AAAE ol g3to]

S|AY FE 4 A St

\begin{sideways}
\begin{tabularx}{7.5cm}{|1|X] 3
< X[} o IS
Q 2
\hline = £
\textbf{normal} & 2 —
— \textbf{tilted} &
\textbf{wider}\\
\hline
normal & \rotatebox{30}% c'%
{I'm tilted!} & e %
I'm wider\\ = <
\hline = )
\end{tabularx} = _
\end{sideways} E g
—
g
J4kol|l %= longtable, supertabular, xtab 22 -85t 1} 7] 2] 50| 3T},
B QoA Mg 223 colortbl Tj7] 2| & o] &3tc}.

40

TABLE 0| =
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Colour by row:\\\vskip 2mm

\begin{tabular}{lcr}
\rowcolor{cyan} Colour by row:
one & two & three\\
\rowcolor{green} one two three
one & two & three\\ one two three
\rowcolor{yellow} one two three
one & two & three\\

\end{tabular}

Colour by column:\\\vskip 2mm
\begin{tabular}
{>{\columncolor{cyan}}1
>{\color{red}
\columncolor{green}}c
>{\columncolor{yellow}}r}
one & two & three\\
one & two & three\\
one & two & three\\
\end{tabular}

Colour by column:

one two | three
one two | three
one | two three

6.1 Table[>Line Spacing(&2] 3j 73)

Hlo| 2o & 7HA -2 Bl AE 9] o|of Brxol A 2Lt 3 o] A|FFs7] Hoj 27HA
247 2] b 7H2 (length) 7} 0pto] 2 Y3t 0] (height) S ZHe Hol ] b Al
\rule 12 EZo] Qlc}. 3 o]0 AL Faw \\ o $A4 1z= Zo|2 x|t
o2 ol & E A}

\begin{tabular}{111}

one & two & three\\

0.3 centimeters & one two three

— \textbf{after} & 0.3 centimeters after this line

this line\\[0.3cm]
one & two & three\\ one two three
one & two & three\\ one two three

\rule{Opt}{1l.2cm}1.2

< centimeters &
\textbf{before} & this 1.2 centimeters before this line
— line\\

\end{tabular}

6.2 Table[>Aligning Numbers($x] 33)

tabularg 12 W 53 F2AM #32] gho] 24 A& 7€ 2 JEslof & it

12 2 |2F2 o] §3He Folth. £AHEhE TS Y HolME
A} &7} 247402 vhAIT

Em‘“
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\begin{tabular}{r@{.}1}
3&14159\\ 3.14159
18661803\\ 1.61803
1841421\\ 1.41421
100800000 100.00000
\end{tabular}
3HH, deolumn 37| A& o|-&5tH D A¥ AXRE F71= & 4 A E=tl, o] A/
A= A 7] QRS ZHath 27} BIK d20] B718 448, 302 Uehhs 2457
(E&2 & o .olth), 28l &7 ol (LEZR) AHSolth. Al HA A12HE A (dot)
o2 1usto] st A4 AF A4S0t L2F 434S UehiA| & 4 e, Tk
o] o] —1o|H FYo| &2 24782 /| F 02 7ted YR tehdet.
ol Hj7] A= Ho] BE YFYo] BF 45t B ety IHFetnE A Fof HAE U &
£ mi= \mbox il FolX BlAE mEZ K3 =5 sfof st

“$\mbox CH4l amsmath®| \textS &

\begin{tabular}{D{.}{,}{4.2}%
D{.3{. }{5}D{.}{. }{-1}}

\toprule

\mbox{One} & \mbox{Two} & One Two Three
\mbox{Three}\\ 10,33 10.33 10.33
10.33 & 10.33 & 10.33\\ 1000 1000 1000

1000 & 1000 & 1000\\ 9,1 5.1 5.1

5.1 & 5.1 & 5.1\\ 3,14 3.14159 3.14159

3.14 & 3.14159 & 3.14159\\
\bottomrule
\end{tabular}

6.3 diagbox(’%!-‘—’l thZA)

diagbox 7] x| = \diagbox §3-& A Z3tc}. >

\begin{tabular}{|1|1|1]|}

\toprule

\diaghox{Lesson}{Date}

- &

Monday & Tuesday\\ Date

\midrule m Monday | Tuesday

Stratigraphy & room A

< & room A\\ Stratigraphy room A | room A
Chemistry & room B & Chemistry roomB | Lab«
<. Lab $\a1pha$\\ PhYSiCS room C Lab §

Physics & room C & Lab

—  $\delta$\\

\bottomrule
\end{tabular}

(5759 of| T 0f slashbox 7 |X| 2 st
290 TeHY S 2{5H0 diagbox IH7 X[ =
slashbox 2| & 74X EFof| CHet X| @S 5t
QUCt 3222 QI Zl slashboxE AHOtCH
oot gl
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6.4 BIEX E A7)

£2]5] Dol Al tabular ] W& st 2= 22 AZ-S dolot. ohdls| A o=
THE tabular W8-S BIEX =2 A5+ Ao EVL Q).

Sin’

« https://www.tablesgenerator.com/
o https://www.latex-tables.com/
« https://tableconvert.com/latex-generator

o https://products.aspose.app/tex/latex-table-generator

6.5 KIEX H°o|EE t°o]¥] 7}x 27

S-2] RojA doje it 2 i YRE sHst= ol & gaé}t}. HIOlEi qu El & o
222 )9 A AL TES th ASCI Tﬂr%‘% ol = ‘zlxlﬂi
Sttt 719 tiEo] AZFHEAE

7
2}
ST} S0 YA ExfE 4 9|

O
H715k= 2] 7}—°Ptﬂ, a8 22k ‘;’E ﬂ—t— 2] %E} o SFelgy 1At Ho|2E0] ot TAB
o o 1L Z2XfLE 7|Ef 2XHE M T EX|2E (Csvel=s
tlolef oo} W82 BIEX & P4 o2 vighsto] Hshe A2 AAR Lolth. oFl o209 ojnjgp= za)) *lE(,):(jEfﬂ
25 uij_%ag UNIx & sh 232 EQld glo]g mtS 9]ojo] AP Zoj gbxo] T =M, 10I1R= 2 28 o| Ao
A

#!/bin/sh
# dat2tex.sh: converts tabular data to a tabular environment
if [ $# != 1 ]; then

echo "Usage: $0 <datafile>"

exit 1

fi

# is this a csv file?

grep ";" $1 > /dev/null
if [ $?2 = 0 ]; then
AWK="awk -F;"
else
AWK=awk
fi

# ok awk,make my day
$AWK '{if (1 == FNR) { \
printf "\\begin{tabular}{"; \
for (1 = 1; i <= NF; i++) {printf "1"}; \
printf "}\n"
)
for (i =1; i < NF; i++) \
{printf $i" & "} printf $NF"\\\\ \n"} \
END {printf "\\end{tabular}\n"}' $1

# end of dat2tex
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7 Tools Hl%

7.1 Tools[>Mail Merges(H ¥ ##])

o] 98513 A7 HoFslA| sl 7152 textmerg H7] x| o] FAE o] Y} EA
g0 EAol| A o] 231} 4, YL upioj R 7heket A2 AYzte| Rl 1 o]9|o]
g2 st

B ol A Pekr| L BB sl Al /o) HE (feld)S A 2|8 Zlolch. Zkzk \Name,
\Surname, \Titleo]2}1l 3}#}. o]oj sfd5l= ZH2 e)& utAd?l data.dat ZFE] 7}4]
er},

\documentclass{article}
\usepackage{textmerg}
\begin{document}

% let's declare the variable fields:
% \Void is for empty lines
\Fields{\Name\Surname\Title-\Void}
\Merge{data.dat}{%

Dear \Title{} \Surname,\\

may I call you \Name?\\

Yours,\\
\hspace{3cm}Guido\clearpage}
\end{document}

u Ha =9l \Voide AA| 3 A2 ol gt dA|E ¢5to] =ik 1 o
apolA 7] &7} 2o Jlet o] A2 dlolg oA Hlo] gl 4 A& YErdct 7t
HREe] 22 ¥l F& it
data.dat ot e] W&-2 o]d 4]0 & &|of 9]}

Guido
Gonzato
Dr.

Francesco
Mulargia
Prof.

Marie
Curie
Mme

7.2 Tools[>Labels(2}2 ZA)

Hd W27} L ohd 2 vhE 7| = o 7hdsich 3x8 AE]F 2hE 84 Q]of] 53 ek 20
NE grEtha S B}, ARSE w 7] 2], I &SHAITE [abelsghe Zlojth, Th2 of| Alofl A
1070 1 k2 1070+ g 5
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https://www.ctan.org/pkg/textmerg
https://www.ctan.org/pkg/labels

\documentclass[adpaper,12pt]{article}

\usepackage{labels}
\LabelCols=3 % n. of columns of labels
\LabelRows=8 % n. of rows of labels

\LeftBorder=8mm % borders of each label

\RightBorder=8mm

\TopBorder=5mm

\BottomBorder=5mm

\LabelGridtrue % show the grid

\numberoflabels=10 % number of labels of each type to print

% the text of the label is specified by

% the \addresslabel[]{} macro:

\begin{document}
\addresslabel[\large] % optional arguments
{\textbf{Guido Gonzato},Ph.D.\\
\textsl{GNU/Linux Sysadmin}}
% now on to the boxed labels
\boxedaddresslabel[\fboxsep=4mm\fboxrule=1mm]
{\textbf{Guido Gonzato},Ph.D.\\
\textsl{GNU/Linux Sysadmin}}

\end{document}

ehgo] N2 The F48 TGS LA steln o)io] 242 HojE 2R 7
(]

\documentclass[adpaper,12pt]{article}
\usepackage{labels}
\LabelCols=3
\LabelRows=8
\LeftBorder=3mm
\RightBorder=3mm
\TopBorder=8mm
\BottomBorder=8mm
\LabelGridtrue
\begin{document}
% use either this environment:
\begin{labels}

1$~{st}$ name

1$~{st}$ address

1$~{st}$ city,state,zipcode

2$7{nd}$ name
2$"~{nd}$ address
2$~{nd}$ city,state,zipcode

3$7{rd}$ name
3$”{rd}$ address
3$7~{rd}$ city,state,zipcode
\end{labels}
% or an external file containing exactly the same text:
% \labelfile{addresses.dat}
\end{document}

7.2 TOOLS[>LABELS(2H& =t4)



textmerg®t labels & Z23sto] &-85l= AT A =sl|E 7] v,

7.3 Tools[>Default Language(t}=°])

BIEX 2] 7|2 doj= Fojoltt. 2|y thE doj = 2|3ttt of 7|4 ddof 2| olzt 3t
‘chapter’ Ut ‘index’2t 22 01 & Z=roofl 87| AAshe= A, S8k sholZulo] A #4,
a8 gy et e FAES VI HRERRE(BE2 \c cH Vet Zo] Y= A
JGdr= A5 9t

KIpX v 22 holl = language . dat 2= 2+ o] ($TEXMF/tex/generic/config/language.

~

dat) Z3tEo] QlEd of 7ol 7t /lof E-2o] 9lt}, o] updg W50} O ARER/}F Qs F o) malg Abg XLt HESH OF BTk,

oy oy o 0| 2A0] Cf| O|Ef I} 2 TeX Live 7t M St=

Stol = 722 7k Qlolg Mg 4 Stk 20192 1 Aleh 0 SX|%10fof i)
Qo] AH&AF7E ob 2t babel 7| A& o3 of| ek o] A&t ATAPHO| TH S HES 4 QUCH= 2N

H= =]
B 2 0N °“‘ﬂ¥9 g gonzf APEXF
SO0l 2101 HEL2 babel OfLt 210
\usepackage[italian,english]{babel} I§7|X| £ 0|85t A0t

I=5°  babel2 ¢ EAE 45t Aojof] AgtstA viit= 4971 et Thef 2217}
Qihe B2go 2 YettA] =t \charxx WAl o2 sl B},

EI R EL A IR YT E Z2HE 221 o E]7F UTF-8 & ol sliot =% sfjof
g g7t 9l 18]l 2018 o] Holl= inputenc®t fontenc T 7] X7} H 2 34,

\usepackage[utf8]{inputenc}
\usepackage[T1]{fontenc}

2018 °|F, BIEX ) 7] & &2} 91292 UTF-8°] H{ct.

HEL D

o] 2 A7t F71eIt. =0l E 2R A= BAE ASte WY EEL2 koTpX
7] Z] () & ©]-83t= ZAolt}. pdflatex, xelatex, lualatex Zt %10l thsto] 3t= 229
L& AFsta 2 FA = FH7I

\usepackage{kotex}

koTgX $lol = g2 EAIsh= 22 2417k flek. thFet dlZlof] oiste] ohafst W o]
7fek=lof Qlt. o] & E9 pdflatexo419] cjk-ko, xelatex°ll 412 polyglossia 5] %12 Ujl
E73] lualatex 3}l A babel 7| #| 2] AF& 7FeAd & &obA] 7kal Qltt,

7.4 Tools>Hyphenation(s}c]Zu|o] )

A 2 BIEX o] Tol Q] sto] uj|o] & 2 X 2] st Hol 2
Sz Zlo]l B d 4 ot 2] sho] &2 fJsiA] At
o U2 P 0 2 o] & 2]& thg1} Zo] s F= A= 7Hssitt

\hyphenation{ge-o-phy-sics ge-o-lo-gy earth}

46 TOOLS Ol


https://www.ctan.org/pkg/babel

o) o] 5ol & 774 Aol o AJoi] ©J5HR ‘earth’2h= Trol = o] Clo A sFo] = X254
247 i}, o] gfol] £ Thoi7} sto] = 2] |x] 947 5t2lwl L ol S \mbox Sl =Tt

Do not hyphen \mbox{internationalisation},please. I'm a masochistic
< man.

7.5 Tools>Spell Check(Z=} A}

ETEX AbAl & E Aol sl 2] 2ottt A2} HAFS I8 A £ ispell, aspell 22 2|7 =0
oJaljof et 2 Unix Al2|IOA ispell S Thgat ZHo] AFE-3F 4= Ql},

shell> ispell -t mydocument.tex

-t 29131 ispellol Al TX 2 BIX 52 FAIstekn 235H ok, wrep ol )
ohUjehe -d 912 2 % Qlo] ARS X sl Fofo

W
e
o

shell> ispell -d italiano -t mydocument.tex

8 Help "+

2RQ1Tf @ mEkol S 9hESh BIEX B T2 A+ B2 Wiio] k. e WhEsl Hotof
St 22 CTAN Ato]Eo|t}h. https://www.ctan.org/tex-archive/info/.
« Unix A2 R 38olA info latex HE= Hel™ BIEX HE 2 7Hdol tisto]
S| S e A S Al e
« https://www.ctan.org/tex-archive/info/LatexHelpBook/ EIEXol thst
o2 55 =&Z 2 A Windowsol it -8 = 2 = of gt

re,

« https://groups.google.com/group/comp.text.tex/topics #A&15S
FoHA & 4 Qi 2% £8S 9 4 Ak 7HAE Aol

o] #AZ WslAtH, tfFE 2] GNU/Linux B Z 3ol Al x| 4= Ql= g Tx/

ETEX Al AR TeX Liveoll 01 Qlek. Zytol] 282 #4E& Al&3th. Y2] Ubuntu

71419 /usr/share/doc/texlive-doc/ T2 E]g] olgjo| A EAE 23 4 Ut o
Liol7h, texdoc 2 B45] -85ttt ol & =01, fancyvrb 7] A5 I th=&

Wee Y.
shell> texdoc fancyvrb

9 mix|=%¢

o] 4= ® Guido Gonzato©l] 2J5}o] Zlu|d| ZE 2 A|&5HH GNU A5 &A] glo] AR
Hj2Z 3t} o] 7to] =7t = 2-0] & 7| & gt} of Aty FHIE gt Zxloj| Al HuUjETh
H oj-¢ 7] & Zio|tt,

7.5 TOOLS[>SPELL CHECK(EX} ZA})
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22 A BN WS

article 222 9] ’IE2 2. 180 B}, ol o B2 A& HF

L=

s},

\documentclass[twoside, 11pt]{book}
\begin{document}

\frontmatter

\begin{titlepage}

\title{The Book of Mine}
\end{titlepage}

\author{John B. Smith}
\maketitle

\tableofcontents

\mainmatter

\part{The Beginning}
\chapter{Introduction}
\section{Let's Start}

The book starts here.

\part{The End}

\backmatter

Thank you for reading this book.
\end{document}

1% A.1: Book template

\documentclass[twoside,12pt]{report}
% tables and figures at the end:
\usepackage{endfloat}
\begin{document}

\title{Final Report}
\author{John B. Smith}
\date{London,\today}

\maketitle

\begin{abstract}

This is the final report.
\end{abstract}

\tableofcontents

\listoftables

\listoffigures

\part{Start}

\chapter{Begin}
\section{Introduction}

The report starts here.
\end{document}

1% A.2: Report template

48

\documentclass[12pt]{letter}
\begin{document}

\address{My address}
\signature{Guido}




\begin{letter}{John's address}
\opening{Dear John,}

Thank you for being my friend.
\closing{Hope to see you soon,}
\ps{P.S. Say hello to granny!}
\encl{My son's photographs!}
\end{letter}

\end{document}

17 A.3: Letter template

\documentclass[adpaper]{article}

\usepackage{typelcm}

\usepackage{times}

\usepackage{color}

\usepackage{rotating}

\pagestyle{empty}

\begin{document}

\begin{sidewaysfigure}
\fontsize{2.5cm}{2.5cm}\selectfont
\centerline{\textcolor{blue}{\textbf{Please:}}}
\vskip 1lcm
\fontsize{4cm}{3cm}\selectfont
\centerline{\textcolor{red}{D0O NOT}}
\centerline{\textcolor{red}{SMOKE}}
\centerline{\textcolor{red}{HERE!'}}

\vskip 1lcm
\fontsize{2cm}{2cm}\selectfont
\centerline{\textcolor{magenta}{If you do,}}
\centerline{\textcolor{magenta}{you'll be \emph{deboned!}}}
\end{sidewaysfigure}
\end{document}

13 A.4: How to write a notice

\documentclass{article}

\usepackage[absolute, showboxes]{textpos}
\usepackage{color}

\usepackage{framed}

\usepackage{graphicx}
\setlength{\TPHorizModule}{10mm} % standard unit of length
\setlength{\TPVertModule}{\TPHorizModule}
\setlength{\TPboxrulesize}{1lpt} % box line width
% start everything near the top-left corner
\textblockorigin{®mm}{Omm}

\thispagestyle{empty} % no page number

\begin{document}
\setlength{\parindent}{Opt}
\definecolor{shadecolor}{rgb}{0.9,1,1}
\begin{textblock}{5}(0,0)
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% this block is 5 modules wide; height is
% automatically determined
\begin{center}
\begin{minipage}[c]{0.8 \linewidth}
\begin{shaded}
This block is placed with its top left corner at the “origin'
on the page,which has been set to (Omm,0Omm). The internal
margin and the shading are provided by the \texttt{minipage}
and \texttt{shaded} environments.
\end{shaded}
\end{minipage}
\end{center}
\end{textblock}
\begin{textblock}{6}(10,1)
\includegraphics[width=6cm,angle=-90]{gnuplot.pdf}
This picture is at (10,1). Note that rotating it
by -90 makes it overflow the margin.
\end{textblock}
\begin{textblock}{5}[0.5,0.5]1(2.5,8)
This block is at position (2.5,8),but because the optional
argument [0.5,0.5] has been given,it is the centre of the block
which is located at that point,rather than the top-left corner.
\end{textblock}
\begin{textblock}{3,4}(6,4)
The dimensions of this block are 3$\times$4 cm.
Its origin is position (6,4) on the page. Note that the text
overflows the margin in some cases; you'll want to
use the \texttt{minipage} environment to prevent that.
\end{textblock}
\end{document}

17 A.5: How to write a poster

B2P 32 Markdown¥} Pandoc oA

(o] B A7} 715k E).) 2.4 A 271513 1= Pandoc HEH7| £ 0]-83}= Mark-

down oA & =22 2Mdst= MES AlEtth. sig 2o HE

ilo
go
()
»
o
In)

title: |
=S 7|0l H=Cf: \
HEE & & 0|4 S W
author: Guido Gonzato
date: 20184 1g¥
documentclass: oblivoir
papersize: b5paper
fontsize: 1lpt
classoption: gremph
numbersections: true
header-includes: |
\usepackage{fapapersize}
\usefapapersize{*,*,30mm,50mm,25mm, *}
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\ifLuaOrXeTeX
\setkomainfont(Noto Serif CJK KR) (* Bold) (Noto Sans CJK KR Light)
\fi
abstract: |
29%FS 7|0 Ho{&2}.

<i--- AMEL O/ WHOE HojgZ -->

# M4 8
2248 *+BE 2T 4 ULt
#7129 (italic)* 2= 7H58tH| 820 of

Alfst=5 2YsloF stot. O7|M= LHHE

HYSHAUCH. Yot HAEE 1Y 22 MY

(]
35 93 AOB [OfXT 4 M] (#theend) 2
# NEMA
‘verbatim text'E MEE £ QLC}.
# OFR|SH MM {#theend}
OFHR| A M ZEStA|I 7| E:
> 0|21, pandocO] O} HRE|| OIUATILI!
2|9 2|2 pandocO| UZA|.

<!l--- end of pandoc_ template ko.md -->

2 S AE oblivoirZ 3HtH HEL article =A17F ©t}. header-includes
H2olA oblivoirg 913t A7 o] Eof o B & thE #A] SejAe o] 25 s S
20| FE & L5k A Y A Qg

Pandoc S Z pdf ¥Zste]H of& B & W=,

shell> pandoc --toc --pdf-engine=xelatex \

pandoc_template ko.md -o pandoc_ template ko.pdf

--pdf-engines xelatex 22 A Qs o] AL X]7} §lo™ pdflatex 2= FHutd
s},

YAML header2] numbersections: = Ao HS & Holgl= Zlojth HH3Y A
OF --number-sections AAE Fol& 2 AiE A=t} Pandoc?] 7|23k AlM

M2 E Alsh= Aol
gkeF TOC7} 8 2 51thH Pandoc A3 & L2 - -tocstH &5ttt

51



	도입
	사전 지식
	예제 보이기에 관하여
	에디터가 지원하는 기능
	패키지 추가하기
	Info 페이지 추가

	문서 작성의 황금률

	File 메뉴
	File▷New(새 파일)
	File▷Save As…(다른 형식으로 저장)
	File▷Save As Template(템플릿으로 저장)
	File▷Import(들여오기)
	File▷Page Setup(페이지 설정)
	Page Setup▷Headers and Footers(상하단 면주)

	File▷Print Preview(출력 미리보기)
	File▷Print(인쇄)
	File▷Versions(버전 관리)

	Edit 메뉴
	Edit▷Autotext(자동완성)

	Insert 메뉴
	Insert▷Breaks(행자름)
	Insert▷Enumerated List(번호부 나열문단)
	Insert▷Special Character(특수문자)
	유로화 기호(AC)

	Insert▷Formula(수학식)
	SymPy 사용법
	Insert▷Footnote(각주)
	Footnotes and Endnotes(각주와 미주)

	Insert▷Indices(목차)
	Insert▷Vertical and Horizontal Space(수평 수직 간격)
	Insert▷Tabs(탭)
	Insert▷Cross Reference(교차참조)
	Insert▷Margin Notes(여백문단)
	Insert▷Text Frame(프레임)
	Insert▷Image(이미지)
	Insert▷Figure(삽도)
	문단을 파고드는 그림

	Insert▷Shapes(도형)
	Insert▷Page(페이지)
	Insert▷Rule(괘선)
	Insert▷Hyperlink(하이퍼링크)
	Insert▷Comment(주석)

	Format 메뉴
	Format▷Line Spacing(행 간격)
	Format▷Character(글자 모양)
	화학반응식의 첨자
	밑줄 긋기
	Format▷Character Size(큰 글자)
	Format▷Character Font(폰트)
	Format▷Character Colour(글자 색상)
	Format▷Character Outline(윤곽선 글자)

	Format▷Paragraph(문단 모양)
	Paragraph▷Horizontal Alignment(정렬)
	Paragraph▷Vertical Alignment(문단 사이의 정렬)
	Paragraph▷Margins(문단 폭)
	Paragraph▷Indentation (들여쓰기)
	Paragraph▷Border and Shade(프레임과 음영)
	Paragraph▷Colour(문단 색상)
	Format▷Columns(다단)


	Table 메뉴
	Table▷Line Spacing(표의 행 간격)
	Table▷Aligning Numbers(수치 정렬)
	diagbox(셀의 대각선)
	LaTeX 표 생성기
	LaTeX 테이블로 데이터 가져오기

	Tools 메뉴
	Tools▷Mail Merges(메일 머지)
	Tools▷Labels(라벨 작성)
	Tools▷Default Language(다국어)
	Tools▷Hyphenation(하이프네이션)
	Tools▷Spell Check(철자 검사)

	Help 메뉴
	마치는 말
	문서 템플릿
	한글 Markdown과 Pandoc 예제

